3D Engineering with Prototyping

Jerome Casey  
*Technological University Dublin*, jerome.casey@tudublin.ie

David Copperwhite  
*Technological University Dublin*, David.Copperwhite@tudublin.ie

Barry Duignan  
*Technological University Dublin*, Barry.Duignan@tudublin.ie

Follow this and additional works at: [https://arrow.tudublin.ie/engschivbk](https://arrow.tudublin.ie/engschivbk)

Part of the Civil Engineering Commons, and the Construction Engineering and Management Commons

**Recommended Citation**

Casey, Jerome; Copperwhite, David; and Duignan, Barry, "3D Engineering with Prototyping" (2004). *Books/Book Chapters*. 4.  
[https://arrow.tudublin.ie/engschivbk/4](https://arrow.tudublin.ie/engschivbk/4)

This work is licensed under a Creative Commons Attribution-Noncommercial-Share Alike 3.0 License
3D Digital Engineering with Prototyping

Jerome Casey, David Copperwhite, Barry Duignan
3D Digital Engineering with ProtoTyping

Jerome Casey
David Copperwhite
Barry Duignan
FOREWORD

Participants will start by learning how to construct the on-screen model prototype (a Juice expresser). To test prototype functionality, attendees will learn how Finite Element and other analysis tools can be integrated with the modelling process. By creating texture maps and animations the working model can be visualised. The prototype is constructed from a suitable material by exporting the digital model to a 4-axis CNC machine. Finally, attendees will learn how to collate all available data into a digital or printed presentation.

Target Audience: Applied Engineering & Designers, Manufacturing & Automotive Engineering, Product Design Engineers, Architects but open to all.

Aim: The course builds an actual prototype but all the skills taught can be easily adapted for any model idea. The main aims of the course are to produce individuals who can:

1. convey 3D model-ideas virtually (through animations/on-screen models).
2. choose an appropriate design after applying FEM and other analysis techniques.
3. produce physical prototypes.
4. collate this data for presentation purposes.

Duration: 25 hours (5 days)

| Day 1: Model Creation (5 hours) Model constructed in Rhinoceros. |
| Day 2: Model Analysis (3 hours) Analysis of the Prototype design carried out using ANSYS and SolidEdge, in particular simulating the loading and behaviour of the finished juicer. |
| Days 3&4: Visualisation (9 hours) Texture maps created in Photoshop and imported into 3D Studio for animation to show the model as it would move during normal operation. The image shown is not a photograph but a model made up using a Texture map (Chrome finish shown here). A light animation will also display the model in an appropriate Photorealistic environment, such as the juicer on a kitchen top. |
| Day 5: Manufacture (2 hours) Model exported to DeskProto for CNC manufacture. The prototype is shown here being milled in balsa wood. Presentation (6 hours) Collating all available data into a digital presentation or printed report. The image shown is the design of the report-cover which will also be presented. |

Process Timeline:
Future Aims - Reverse Engineering:
Another area that the course may move into is the teaching of reverse engineering techniques combined with rapid prototyping. A Microscribe 3D Digitising arm is presently located in Advanced Manufacturing, Room 101, DIT Bolton St. The arm, shown right, works by tracing over the contours of a physical object and can build a complex 3D model in a matter of minutes. The arm can be connected to a laptop via its USB port and imported directly into a compatible software application such as Rhinoceros. One advantage of this setup is that the digitising solution is also highly portable - the arm is relatively small in size and coupled with the laptop, easy to transport.

For example the arm could be used to digitally outline the surface of a mobile phone, then the digital model could be imported into Rhinoceros and variations made to its shape. Subsequently the remodelled shape can be sent to CNC for presentation to a prospective client.

Other Prototype Ideas:
Our main target audience for the course is Product Design, Automotive Design and Architecture (images 1-5). However Prototyping is also used widely in other areas, as shown below, such as sculpturing art, toys/ model submarines, confectionery, packaging design, cosmetics, jewellery, footwear, aviation and the Navy.

Images 1-4 copyright of David Copperwhite, 5-10 copyright of DeskProto, 11-12 copyright of Delcam.

Jerome Casey

May 2004
# Table of Contents

**Foreword** .................................................................................................................. 1

**Using Rhinoceros to Create Models** ........................................................................... 2

1.1 The Rhino Interface ................................................................................................. 2
1.2 Warmup Exercises ................................................................................................. 3
1.3 Line Creation of the Gear-Housing ....................................................................... 6
1.4 Dimensioned Drawing of the 2D Profile ................................................................. 9
1.5 Creating Surfaces and Adding the Fillets ............................................................... 9
1.6 Editing the Surface Created .................................................................................. 12
1.7 Constructing the Side Protrusions ........................................................................ 14
1.8 Checking the Model Body for Surface Defects ..................................................... 16
1.9 A Recap of the Menu Structures .......................................................................... 19
1.10 Shortcuts .................................................................................................................. 20

**Creating the Part Using Features** ............................................................................ 23

2.1 Creating the Part in Solid Edge ............................................................................... 23
2.2 Creating a Feature .................................................................................................... 23
2.3 Creating the Main Block ....................................................................................... 24
2.4 Creating the Sloped Back ...................................................................................... 24
2.5 Rounding the Back .................................................................................................. 25
2.6 Creating the Rounded Front Part .......................................................................... 25
2.7 Continuing With the Part ....................................................................................... 26

**Feature Based and Constraint Based Design** .......................................................... 27

2.8 Normal CAD Modelling ......................................................................................... 27
2.9 Associativity of Dimensions .................................................................................... 27
2.10 Constraint-Based Modelling .................................................................................. 27
2.11 Variables .................................................................................................................. 28
2.12 Parts and Assemblies ............................................................................................. 28
2.13 Creating Parts ........................................................................................................ 28
2.14 Profiles ..................................................................................................................... 29
2.15 Standard Features .................................................................................................. 29
2.16 Assemblies .............................................................................................................. 29
2.17 Standard Components ........................................................................................... 30
2.18 Modelling Ability ................................................................................................... 30
2.19 Data Exchange ........................................................................................................ 30
2.20 Productivity ............................................................................................................. 32

**Finite Element Analysis Using DesignSpace** ............................................................ 35

2.21 Aim ......................................................................................................................... 35
2.22 Assumptions .......................................................................................................... 35
2.23 Starting the Package .............................................................................................. 35
2.24 Opening the Part Geometry ................................................................................... 35
2.25 Specifying Material .............................................................................................. 36
2.26 Manipulating the Model ....................................................................................... 36
2.27 Adding Supports ...................................................................................................... 36
2.28 Adding Loads ......................................................................................................... 36
2.29 Selecting Results .................................................................................................... 37
2.30 Look at the Mesh .................................................................................................... 37
2.31 Solve the Problem .................................................................................................. 37
2.32 View the Results .................................................................................................... 37
## DIGITAL PRESENTATIONS: POWERPOINT

- **5.20 Getting Started in PowerPoint** .................................................. 90
- **5.21 Changing the Background Design** .................................................. 91
- **5.22 Adding a Picture or an Animation to a Slide** ..................................... 92
- **5.23 Adding a Watermark and Action Buttons to the Slide Master** .................. 93
- **5.24 Inserting a Bulleted List Slide** .................................................. 95
- **5.25 Inserting a Table Slide** .................................................. 95
- **5.26 Using Microsoft Draw in Slides** .................................................. 95
- **5.27 Adding Transition and Build Effects to Slides** ..................................... 96
- **5.28 Creating an Agenda Slide** .................................................. 98
- **5.29 Creating Hyperlinks from the Agenda Slide** .................................... 99
- **5.30 Viewing Your Presentation** .................................................. 100
- **5.31 Printing Your Presentation** .................................................. 100

## REPORT WRITING USING WORD

- **5.32 Applying the Built-in Heading Styles** ............................................. 102
- **5.33 Inserting the Table of Contents** ............................................. 103
- **5.34 Creating a Style by Example** ............................................. 103
- **5.35 Adding Section Breaks** ............................................. 104
- **5.36 Inserting Headings** ............................................. 104
- **5.37 Inserting the Page Numbers** ............................................. 105
- **5.38 Inserting the Index** ............................................. 105
Day 1: Model Creation (5 hours)
**USING RHINOCEROS TO CREATE MODELS**

1.1 THE RHINO INTERFACE ................................................................. 2
1.2 WARMUP EXERCISES ........................................................................ 3
1.3 LINE CREATION OF THE GEAR-HOUSING ....................................... 6
1.4 DIMENSIONED DRAWING OF THE 2D PROFILE ............................... 9
1.5 CREATING SURFACES AND ADDING THE FILLETS ............................ 9
1.6 EDITING THE SURFACE CREATED ................................................. 12
1.7 CONSTRUCTING THE SIDE PROTRUSIONS ..................................... 14
1.8 CHECKING THE MODEL BODY FOR SURFACE DEFECTS .................. 16
1.9 A RECAP OF THE MENU STRUCTURES ......................................... 19
1.10 SHORTCUTS ................................................................................. 20

In this module using *Rhinoceros* we will start by creating the basic 2D profile of the juice expresser part – the gear-housing – and then later use this to generate the 3D surfaces. This is followed by some surface editing involving various techniques such as extruding and filleting of edges. Finally we will apply some checks on the surface integrity and continuity. But first we must be introduced to the program's interface.

**1.1 The Rhino Interface**

Open your *Rhinoceros* application. The screenshot of the interface shows the standard convention of 4 views, each with its own separate window. The main reason for having 4 view-ports is so that you have a flat view of the objects from three sides.

The term often used is **planar-views**. The 3 basic views are **Top**, **Front**, and **Right**. The fourth view is called the **perspective-view**. The perspective view is a useful view simply because it swivels if turned by the mouse while the cursor is in the view-port. In addition if you have a mouse with a roller wheel you can zoom in dynamically while you are turning your model 360 degrees. Thus the four view-ports will be your primary means to communicate with the model as you build it during this class.
Tip:
- Double-click on the view-port name to see full-view.
- Right-click on the view-port name to see view and zoom commands for that window.
- Use the roller-wheel on your mouse to zoom in and out of your model.
If you do not have a roller-wheel mouse, hold down the SHIFT key then right-click and move the mouse to see your model move.

Tip: If you are using Rhino version 3 or later:
Hold down the Ctrl and ALT keys then hit:
W to open Wire frame view
R to open Render view
G to open Ghosting view

1.2 Warmup Exercises
Take the cursor that appears just after you launch Rhino and move it to the left of your screen where a Toolbar called Main-1 is positioned. This contains all commands of a line type nature such as straight and curved lines. In cases where the menus are laid out differently you can just type in the word Line at the Command prompt or select line from the top menu. This is very similar to AutoCAD.

Let's start by selecting the line command. Click on the icon on the Toolbar. The Command Prompt will change to Start of Polyline. Switch to the Front view port. We now need some form of data input such as measurements taken from the model to feed the line command prompt so it can generate a line to the required length. You will see this at the top of your screen. Alternatively we can click on the screen and move the line and click again. Normally we could use a grid and snap to it. Either is accurate for our next exercise.

One way of directly entering measurements is by using Polar-Co-Ordinates. If you go to the Command Prompt at the top of you screen you will see Command: and a flashing cursor. Here you can type in a command and values and the program will process it, instead of using the mouse or the menus.

The Command Prompt showing the exact values being entered.
Try this line exercise as a basic example to start with. Switch to the front view port by clicking on the view-port name. Type in Line/Polyline at the prompt and click near the Origin (0,0). Now enter the following series of numbers on the next line of the command prompt. Hit return to enter.

100<0
100<90
100<180
C

C=tells the program to close the shape automatically

You should have a basic shape of a box, as illustrated below.

Fundamentally a 2D profile is created when you join the four lines up. You will find the Join command in the Edit menu, which is second from the left or by clicking on the icon.

As we can see the box we have just created is constructed with straight lines drawn at 90 degree angles. We’ll learn next how to draw lines which are at other angles to the horizontal or vertical.

To create a line at an angle to a vertical line like the box we have just created all we do is place the numeric value for the angle into the command prompt. This is done in the same way as before. Start the line command and type 0,0,0 to centre the start of the line. Hit return to enter. Type the following into the command prompt:

100<330

This creates a line of length 100 at an angle of 330 degrees (anticlockwise) to the horizontal.
Now we will quickly look at the Curved-Line Tool.
When constructing curved-lines it is quite common to create a frame of construction lines which will give us points to snap onto. In this final warmup exercise we will create a sample of construction lines, then attach the curved line to the end-points.

**Tip: The OSnap Menu:**
This menu is quite important for re-connecting from one line to the end-point or midpoint of another line. There are many other types of snap connections that will be explored during these exercises.

Start from the previous angle line which we created, and draw a line downwards 100mm.
Input @100<270
Then go 10mm to the right and up 95mm. This gives us the first construction point.
Now repeat the same process but change the numbers.
This time it is still 10mm to the right but 88mm up to your second construction point.
Use 81mm and 74mm, for the other uprights.
When you have completed, join up all the lines.

Now we are ready to start to construct the 2D profile of the gear housing.
In this exercise we will make use of the Line command & the Interpolate-Curve command as discussed earlier.

Something else to point out is that the above points can be moved by simply using the function key F10 and touching the desired points and dragging them where you desire. Transforming or moving them in a numerical way by using the arrow keys on the keyboard can also move the points.
1.3 Line Creation of the Gear-Housing

First click on the front view-port. Now select the line command either by clicking its icon or from the menu by selecting Curve|Line|Single Line. To generate a line to the exact length, enter the exact values in the line command prompt. The command prompt is located at the top of your screen.

Process Timeline - Creating the 2D Profile from Start to Finish

Step 1: Start by selecting the line command. Input the numbers 0,0,0 and the line will jump to the centre of the red & green lines, (the origin). Now enter the next stage of the line command by inputting the numbers @4.2<90 and the first line of the profile will be created, the vertical line.

Step 2: Snap onto the end of the previous line and input the numbers @25.7<180 to create the horizontal line.

Step 3: Snap onto the end of the previous line and input the numbers @69<270 to create the vertical line.

Step 4: Snap onto the end of the previous line and input the numbers @26<0 to create the horizontal line.
Step 5: Snap onto the end of the previous line and input the numbers $@11.8<101.91$ to create the line.

Step 6: Snap onto the end of the previous line and input the numbers $@37.6<90.06$ to create the line.

Step 7: Snap onto the end of the previous line and input the numbers $@22.1<270$ to create the vertical line.

Step 8: Snap onto the end of the previous line and input the numbers $@26.1<0$ to create the horizontal line.

Step 9: Snap onto the end of the previous line and input the numbers $@34.1<90$ to create the vertical line.

Step 10: Now most of the line work has been completed. We will start to build the curved line. This is done by building lines of different lengths and by putting points on the ends. This is a repeat of the earlier warmup exercise.
Step 11: Now select the points for the `interpolate-curve` command. This command allows you to draw your line through a series of points in space. By using a curved line tool we can snap to the end to generate the lines.

**Tip:** Transfer the construction lines to a new layer, then switch off the layer. Later if you need to change the shape of the curve, you can switch the layer back on and alter the lengths.

Step 12: Snap onto the end of the Curved line and the first line thus creating a line of length 37.9. Now the 2D profile is complete. From the menu select Edit| Join, and join all the lines together.

Step 13: Now we need to create two construction lines to place the larger circle at the centre. Input @30.4<0 and @21.8<270.

Step 14: Click on the Circle icon (under the line icon) and snap to this point. In the Command prompt type 12.5 and hit return. Snap again to the centre and create a circle of radius 8.5. Construct the smallest circle in a similar manner.
1.4 Dimensioned Drawing of the 2D Profile

To fillet the edges as shown below, first select the relevant line and then from the menu choose Solid| Fillet Edge

Fillet on no.1  = 3.25mm  
Fillet on 2,3,4  = 1.619mm  
Fillet on 6  = 5.6mm  
Fillet on 7  = 13.7mm  
Fillet on 8  = 1.619mm  
Fillet on 9  = 1.619mm

Now switch to Perspective-View.
Step 1: We have an enclosed shape, or 2D profile.

Step 2: Now select the 2D-profile which will turn yellow to signify that it is selected.

Step 3: From the menu select: Solid| Extrude Planar Curve| Straight. We will use the Bothsides option. Extrude by 13.5mm.

Step 4: The shape will look as above when extruded. Now we can start to edit the shape.

Step 5: Select the edge to apply a fillet. From the menu select Solid| Fillet Edge and input 3.25mm for the fillet size.

Step 6: The 3.25mm fillet is added on edge1.

DAVID COPPERWHITE USING RHINOCEROS TO CREATE MODELS
Step 7: Now select the full side of the shape. This is marked in yellow. Input 12mm for the fillet size.

Step 8: The edge becomes rounded in the Fillet edge operation. Also add a 12mm fillet to the upper face as shown.

Step 9: The completed upper face, the back is also a 12mm fillet edge.

Step 10: The final Nurb surface generated after all the filletting is completed. Apply an Emap now to visualise the surface.

Step 11: Now we should have a nicely rounded shape ready for further editing.

The picture shows the model in all 4 views with the Arches.png Emap.
1.6 Editing the Surface Created

We now need to create three hollow portions in the solid using the Boolean command, two of which are cylindrical and one of which is cuboid. The cylinders are created by extruding from circles, the cuboid is created by extruding from a rectangle.

Process Timeline: Further Editing of the Surface

Step 1: A circle with a 9mm radius is placed in the centre of the filleted shape and extruded to make a cylinder.

Step 2: Once in position, the shape is extracted by using the Boolean command: from the menu select **Solid Difference**.

Step 3: Now we have removed the second shape from the first leaving a hollow shaft.

Step 4: We repeat the same process with the same sized shape (9mm radius) and apply a Boolean once more. Extend the cylinder by about 30mm into the shape.
Step 5: The result leaving a hollow shaft. A vertical steel bar, attached to a support-stand, will be inserted here to support the gear-housing and assembly.

Step 6: Now to construct the cuboid shape. Switch to Top view.

Step 7: Construct the rectangle with dimensions: $47.2 \times 23.6 \text{mm}$.

Step 8: The shape is extruded, moved into position and removed by again applying a Boolean difference.
1.7 Constructing the Side Protrusions

There are two side-protrusions to construct. The first is a hollow cylindrical port, into which the lever-arm is inserted to turn the gear. The second is a small spherical bump-protrusion on the same axis but on the opposite side of the shape.

Step 1: First we construct the hollow cylindrical port. This is achieved by extruding the concentric circles drawn earlier.

Solid| Extrude Planar Curve| Tapered.
Extrude to a depth of 25mm, tapered by 1mm.

Step 2: Now we again visit the solid commands, but this time from the menu select Solid| Union to attach the side protrusion to the main shape.
Step 3: Once the protrusion is attached use the **Solid| Fillet Edge** command to apply a small 2mm fillet to the join between the shape and the protrusion.

Step 4: Repeat by adding another fillet of 2mm to the top edge.

Step 5: Finally apply the fillet edge to the outer edge of the protrusion. Use a 2mm fillet.

Step 6: Now make a sphere of radius 25mm on the same axis but on the opposite side of the shape. Select **Solid| Sphere** from the menu. Move the sphere until it protrudes approx 3mm. Add this protrusion using the **Union** command.
1.8 Checking the Model Body for Surface Defects

The visuals below show checks carried out on the completed model. Here we are checking for defects such as badly fitting surface edges, surfaces which do not blend well together, or ones with badly formed relationships with connecting surfaces.

From the menu select Analyze | Surface | Environment map. This option allows us to view our final shape for surface analysis. We will be able to select from a variety of maps. Some maps are better than others at showing up defects on shapes. Therefore we have chosen to use the sunroom2.png file to look directly at the surface close up.

By using the zoom command and then swivelling the mouse we can get extremely close to any surface to check visually if it is correct. If not, you need to rebuild the model until the surface is refined.

An example of slight surface defects identified with the sunroom2.png map. The True-Sphere.jpg map is shown applied to the same shape.
The Gear housing is shown in position with the remaining parts. These parts will be supplied for the next modules on Analysis and Animation.

The Arches.png Environment map.
The sunroom2.png Environment map.

Additional parts of the juicer shown in relation to the gear-housing. The sunroom2.png Environment map is used.

DAVID COPPERWHITE USING RHINOCEROS TO CREATE MODELS 18
1.9 A Recap of the Menu Structures

Solid| Extrude Planar Curve| Straight
| Along Curve
| To Point
| Tapered

Solid| Sphere| Centre, Radius
Solid| Extrude Surface

Edit| Join
Curve| Line| Single Line

**Boolean Commands:**
Solid| Union
Solid| Difference
Solid| Intersection

Analyze| Surface| Environment map

Rhino version 1.1 to 3.
[http://www.rhino3d.com/support/faq](http://www.rhino3d.com/support/faq)
# 1.10 Shortcuts

<table>
<thead>
<tr>
<th>Action</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>Ctrl+N</td>
</tr>
<tr>
<td>Open</td>
<td>Ctrl+O</td>
</tr>
<tr>
<td>Save</td>
<td>Ctrl+S</td>
</tr>
<tr>
<td>Print</td>
<td>Ctrl+P</td>
</tr>
<tr>
<td>Undo</td>
<td>Ctrl+Z</td>
</tr>
<tr>
<td>Redo</td>
<td>Ctrl+Y</td>
</tr>
<tr>
<td>Select all objects</td>
<td>Ctrl+A</td>
</tr>
<tr>
<td>Cut</td>
<td>Ctrl+X</td>
</tr>
<tr>
<td>Copy to Clipboard</td>
<td>Ctrl+C</td>
</tr>
<tr>
<td>Paste</td>
<td>Ctrl+V</td>
</tr>
<tr>
<td>Delete</td>
<td>Delete</td>
</tr>
<tr>
<td>Pan</td>
<td>Shift + drag with the right mouse button. In parallel views like the default Top, Front, and Right view, drag with the right mouse button. Press and hold Shift or Ctrl and press the arrow keys.</td>
</tr>
<tr>
<td>Pan forward</td>
<td>Ctrl+PageUp</td>
</tr>
<tr>
<td>Pan backward</td>
<td>Ctrl+PageDown</td>
</tr>
<tr>
<td>Zoom in</td>
<td>Ctrl + drag up right mouse button. If you have a wheeled mouse, you can rotate the wheel to zoom in and out. PageUp.</td>
</tr>
<tr>
<td>Zoom out</td>
<td>Ctrl + drag down with the right mouse button. If you have a wheeled mouse, you can rotate the wheel to zoom in and out. PageDown.</td>
</tr>
<tr>
<td>Zoom Previous (Undo view change)</td>
<td>Home</td>
</tr>
<tr>
<td>Zoom Next (Redo view change)</td>
<td>End</td>
</tr>
<tr>
<td>Rotate</td>
<td>Ctrl + Shift + drag with the right mouse button. Perspective views and parallel views that are not looking perpendicular to the construction plane rotate with the right mouse button.</td>
</tr>
<tr>
<td>Rotate Down</td>
<td>Down Arrow</td>
</tr>
<tr>
<td>Rotate Left</td>
<td>Left Arrow</td>
</tr>
<tr>
<td>Rotate Right</td>
<td>Right Arrow</td>
</tr>
<tr>
<td>Rotate Up</td>
<td>Up Arrow</td>
</tr>
<tr>
<td>Tilt left</td>
<td>Ctrl+Shift+PageUp</td>
</tr>
<tr>
<td>Tilt right</td>
<td>Ctrl+Shift+PageDown</td>
</tr>
<tr>
<td>Adjust the lens length of the camera in a perspective view.</td>
<td>Shift+PageUp</td>
</tr>
<tr>
<td>Adjust the lens length of the camera in a perspective view.</td>
<td>Shift+PageDown</td>
</tr>
<tr>
<td>Help</td>
<td>F1</td>
</tr>
<tr>
<td>Command History</td>
<td>F2</td>
</tr>
<tr>
<td>Feature</td>
<td>Shortcut</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>----------</td>
</tr>
<tr>
<td>Grid toggle</td>
<td>F7</td>
</tr>
<tr>
<td>Ortho toggle</td>
<td>F8, Shift, Ortho pane on the status bar.</td>
</tr>
<tr>
<td>Snap toggle</td>
<td>F9, Snap pane on the status bar.</td>
</tr>
<tr>
<td>Points On</td>
<td>F10</td>
</tr>
<tr>
<td>Points Off</td>
<td>F11</td>
</tr>
<tr>
<td>Click Digitizer</td>
<td>F12</td>
</tr>
<tr>
<td>Set Maximized Viewport Top</td>
<td>Ctrl+F1</td>
</tr>
<tr>
<td>Set Maximized Viewport Front</td>
<td>Ctrl+F2</td>
</tr>
<tr>
<td>Set Maximized Viewport Right</td>
<td>Ctrl+F3</td>
</tr>
<tr>
<td>Set Maximized Viewport Perspective</td>
<td>Ctrl+F4</td>
</tr>
<tr>
<td>Next Viewport active</td>
<td>Ctrl+Tab</td>
</tr>
<tr>
<td>Previous Viewport active</td>
<td>Shift+Ctrl+Tab</td>
</tr>
<tr>
<td>Layer</td>
<td>Right click the Layer pane on the status bar.</td>
</tr>
</tbody>
</table>

Many of these shortcuts can be changed and you can add new shortcuts and aliases. See Options dialog box, Shortcut Keys tab and Aliases tab.
Day 2: Model Analysis (5 hours)
We will now recreate one of the components, the top of the juicer, using a feature based system, Solid Edge. You can start the part using the instructions below, and continue afterwards using some of the information you used with Rhino.

2.1 Creating the Part in Solid Edge

The process for making the part is as follows:

1. Create a block (protrusion feature) which will accommodate the main part up to the rounded part at the front.
2. Create a cutout feature which will shape the sloped part of the block.
3. Create a round feature on the sloped back.
4. Create a cylindrical protrusion for the front of the block.
5. Create a fillet to smooth the transition between this part and the main part.
6. Create a shell feature to hollow out the interior of the block.
7. Creating protrusions to finish the shape of the interior.
8. Creating a cutout for the lower cutout shape.
9. Creating a cylindrical protrusion for the arm bracket.
10. Applying draft and hole features to this item.
11. Continuing as desired.

This sequence is only one way in which this part can be developed. There are many other valid ways – the right choice will be anticipated by experience.

2.2 Creating a Feature

The first stage in creating a feature is to draw the geometry on a plane. The plane can be one of the three basic planes (x-y, x-z, y-z), or it can be a flat surface on an existing part, or it can be otherwise defined in a number of ways.

The next stage is to sketch the geometry. There are numerous drawing aids, which help you to draw vertical lines, or to snap to midpoints, endpoints etc.
2.3 Creating the Main Block
- select the draw function on the left hand toolbar.
- select the xy plane – a window will now open up for the 2D sketch.
- click on the rectangle icon on the left hand toolbar.
- now click and hold the mouse over the origin. Drag it up and right and release when you have drawn the appropriate shape.
- click the smart dimension key on the left hand menu and select the horizontal line. Set it at 76.5mm. The rectangle will change shape accordingly.
- do the same for the vertical side, and set it at 21mm.

The 2D sketch is now finished. Press the Finish button. A second finish button will appear – press that also. The sketch will now be visible in 3D and will go purple. You now need to create a protrusion feature:

- click the protrusion button. A lower toolbar will appear.
- click the select-from-sketch button.
- select the sketch previously drawn, and click on the tick mark. A red outline will now appear showing the extruded object. Now enter 83mm into the distance box, and click on the screen to indicate which side. Now click finish.

The first feature is now created.

2.4 Creating the Sloped Back
The sloped back is created using the cutout feature. The 2D profile for the cutout is a closed curve similar to that shown below, drawn on the plane of the side of the block.

- click on the cutout button on the left toolbar.
- a toolbar will appear – the create sketch button will already be highlighted. Watch the messages which appear at the bottom of the screen. You will be asked to select a plane for the sketch.
- move the cursor until the side of the block is highlighted and click.
- now select the bottom edge of the block to denote the orientation of the plane.
- now pick the left-hand end of the plane to further define it.

You will now be back in the 2D sketch plane. Try and create a closed loop of lines and arcs similar to that shown below. Make sure that you draw a closed loop, and that the loop fully encloses the part to be removed. When you click finish, you will create the cutout in the same manner as you created the block.
2.5 Rounding the Back
In order to create the rounded back, we will create round features (radius 13) on each side of the sloped back. Click the round button \( \square \). You then click on each of the edges to be rounded, type in the radius and hit the tick mark. You will be offered a preview button. Click this once you have all the proper selections. Then click finish if the feature looks right.

2.6 Creating the Rounded Front Part
This is created using a circular protrusion which is extruded up to a height of 87mm. You should draw a circle on the xy plane whose diameter is the width of the block. You should be able to snap to the midpoints and endpoints of appropriate lines in the existing geometry. The circular profile is then extruded up a distance of 87mm. Midway through, you should be seeing something like the following:
2.7 Continuing With the Part

Now try and create other features of the part – start with the shell command to hollow out the part to a thickness of 2mm.
Feature based CAD packages are different from the more traditional packages for several reasons. We will look into these issues below.

### 2.8 Normal CAD Modelling

In normal CAD systems, objects are created using standard menu commands and dimensions are supplied as numerical inputs or taken from existing geometry (e.g. with object-snaps). Once entered, the dimensions of the objects are usually not directly changeable, particularly with 3D solids, except using commands such as stretch. This is critically the case for more complex models.

### 2.9 Associativity of Dimensions

Associativity between dimensions and geometry means that you can specify a dimension as a variable – if an object is altered using a commands such as stretch, then the dimension will change with the object, provided its datum points are included in the stretch. However, this associativity does not work the other way – changing a dimension will not alter the geometry of the model. Objects which have this bidirectional associativity can be changed by editing dimensions. This capability is called dimension-driven design. These dimensions can also created using variables, so for example, the length of an object can be specified as "L1" instead of "100.0", thus allowing the geometry of the object to be controlled other than by editing commands.

### 2.10 Constraint-Based Modelling

In order to keep control over the shape of objects, it is essential that changing dimensions does not produce the wrong object. This can be done using constraints, which define dimensions and other relationships (concentricity, parallelism, collinearity, perpendicularity etc.). It is essential that in constraint-based modelling systems, objects are properly constrained – underconstrained objects will not be properly defined while overconstrained objects can be problematic to edit. Therefore, constraint-based systems tend to force the user to properly constrain geometry on creation, so that there will not be problems later on.

However, once constraints have been properly entered, the model can be edited quite simply by changing dimensions. Provided that the new dimension does not make the
object violate its constraints, the change will be made. This has the advantage that objects can be set up so that only certain key dimensions may be changed, and that changes to these dimensions will maintain desired constraints.

2.11 Variables
If dimensions are entered in the form of variables, this allows for further flexibility, since it allows for the direct control over dimensions. Also, variables can be entered in equation form, so that certain relationships can be maintained between dimensions which may not otherwise be available. For example, if the slot shown in the object below must be maintained centrally, it can be done by defining its position in terms of the width of the slot and the width of the object:

\[
\frac{(W_T - W_S)}{2}
\]

These variables may be changed from a dialog box, and may be filled from external applications such as tables or spreadsheets.

2.12 Parts and Assemblies
One important part of a package such as Solid Edge is that it is geared towards the construction of parts and assemblies rather than simple geometrical models. This has several implications for functionality and productivity.

2.13 Creating Parts
Parts are the standard objects created in the package. A part can be thought of as the sum of the operations and components required to make it. In some way, this is a similar concept to the idea of Constructive Solid Geometry with its primitives and boolean operations. This is reflected in the tree structure seen in the right-hand side of the screen. Parts are usually made from the following objects:

- Solid primitives which have been converted into parts
- 2D profiles which have been extruded or rotated into three dimensions

These parts can then be augmented by:

- features made from 2D profiles drawn on workplanes placed on the part
- standard features such as holes, bosses etc
These features can be arrayed and located using constraints, dimensions and variables. This process allows complex models to be made, and since each step of the process must be properly constrained, complex parts may be made. It is essential that the CAD program itself is able to maintain constraints over large models – this can however have the unfortunate effect of making the creation phase seem unnecessarily complex to the beginning user.

2.14 Profiles

2D profiles are used to extrude or rotate into 3D components or to create surface features on existing 3D geometry. As a productivity aid, Solid Edge will allow the rough sketching of 2D geometry on working planes. This rough geometry can be solved i.e. the package will apply whatever constraints appear appropriate. For example, if two lines are almost at 90°, a perpendicularity constraint will be applied. The user can then apply further constraints as required. Dimensions may be added as required.

2.15 Standard Features

Most of the detailing on mechanical equipment consists of standard items such as slots, holes etc. These can be easily placed on parts using the available menus in mechanical desktop. As an example consider the hole feature dialog box:

![Hole Feature Dialog Box](image)

This dialog box allows a hole feature to be set up using engineering concepts such as drilling blind or through, counterboring or countersinking and tapping. A number of options are also available for placement on the existing part. Once placed, these features may be controlled using constraining dimensions, arrayed etc.

2.16 Assemblies

Assemblies consist of several parts forming a single larger entity. Solid Edge Assembly allows assemblies to be defined from individual parts which have been predefined. Parts in assemblies are instances of these predefined parts, just as blocks in a normal drawing are instances of a predefined block. Therefore, multiple instances
of a single defined part can be used in an assembly. These instances are constrained in
the same way as the other objects previously discussed.

2.17 Standard Components
Many assemblies contain lots of standard components such as bolts, fasteners etc.
These components are generally available as libraries which either come with the
package or are available independently. In any case, they contain standard
components which are used as parts in assemblies.

2.18 Modelling Ability
Solid Edge contains a comprehensive set of surface modelling tools, including:

- Full NURBS support for lines and surfaces
- Shell command to create a surface shell from solid objects
- Blending and fillet functions with varying or constant radius
- Surface creation options including: extrude, revolve, loft, offset, etc.
- Point-wise manipulation of surface patches
- Manipulation of vectors controlling blending and other patches
- Projection commands (e.g. wire-on-surface etc.)

2.19 Data Exchange
It is a very common occurrence that data must be exchanged between CAD packages
— for example, different organisations may have different packages, or organisations
may use specialised packages for different parts of the design and engineering
process. In some sectors, some packages have become a de facto standard, but this is
not common.

Exchange of models between packages has certain problems: Firstly, the format of
files is proprietary and vendors are often reluctant to make this known. Secondly,
different packages model to different levels of sophistication — for example, a surface
modelling package has no concept of solids and cannot read or write them. Thirdly,
different entities can be represented in different ways in different packages — surfaces
can be NURBS, b-spline surfaces or coons patches.

If data has to be exchanged between packages, there are two main strategies:

1. Translators
The most reliable way to exchange data between packages is to have a translator
which is custom-built. This ensures maximum accuracy and stability. However, it is
specific only to the packages it is written for and may not even work for different
versions. This approach is common where CAD packages have to interface with
packages doing other things, such as analysis.

2. Neutral file formats
Broadly speaking, these are file formats which are not native to a particular system,
and whose structure and capabilities are known. Packages read and write files into this
format. The advantage of this approach is that a single translator which can read and
write a particular format allows the package to exchange data with a large range of
other packages. The disadvantage is that there can be some inconsistencies, especially in the precise representation of objects and with units and tolerances. Some neutral files are:

IGES (initial graphics exchange specification) – one of the oldest formats and one of the most widely available. Has some limitations with more advanced modellers and can require much tweaking of translation parameters. Not always the best option but can be useful.

STEP – this is an advanced product data exchange standard which emerged from a series of EU cooperative research projects. After a long gestation, it is now fairly widespread and is a valuable standard with applications far beyond exchange of CAD models.

Parasolid – this is not quite a neutral format. It is the native format of a solid modelling engine called Parasolid, used by several packages including Solid Edge. Any package based on Parasolid will use this format, and many other packages have good quality translators.

SAT – this is the native format of another solid modelling engine, called ACIS. ACIS is used by several other packages, for example Solid Works, and some versions of AutoCAD.

DXF - this is a drawing exchange format developed by Autodesk and is commonly used by other vendors.

Typical use – IGES
The IGES translator allows for some flexibility in how the file is exported. If the file is to be exported to a CAD package for example, dimensioning, drawing views etc. However, if the file is to go into something like a finite element analysis package, it may be better to leave these objects out of the IGES file, even though the importing package should ignore them if it is not a draughting package. Also, surfaces and solids are represented in different forms on different packages, so some effort should be made to export the geometry in a form more suited to the importing package if possible.
2.20 Productivity

Drawings
One of the most powerful productivity features is the ability to automate the draughting process. *Mechanical Desktop*, in addition to other similar packages, does this by offering standard or customised templates containing the standard views (top, front, side etc.) of components with the addition of specialised views such as sections (possible because of the solid modelling capability used). Also, dimensions can be automatically placed, based on the presence of features etc. on the parts. Even though this automatic dimensioning may not be exactly what is required, it is usually useful as a first draft. Another feature is the ability to produce a bill of materials from the part information.

Table-driven design
Variable dimensions (variables) can be utilised to create families of similar parts. These variables can easily be driven from tables, using a feature internal to mechanical desktop or from external data sources such as *Microsoft Excel*. Also, significant flexibility is afforded in this area by the adoption of *Visual Basic for Applications (VBA)*, which allows programmers a familiar environment and commonality with many other applications. *VBA* is particularly good at providing GUI components and accessing remote data sources (e.g. databases via *ODBC*, *JET*, *SQL* etc.). This can allow the creation of full-fledged applications which run on top of *Mechanical Desktop*, streamlining its use by ensuring that the created application handles the sometimes difficult task of creating a fully constrained and properly constructed model.

Example of a set of parts in Autodesk's Mechanical Desktop.
The above parts imported into ANSYS via an IGES file. Volumes were created on importation, but note that some components are not positioned in precisely the same position.

Assembly of components showing hierarchical structure of assembly, parts, profiles and other features on the left.
Various surface modelling and construction options available.
2.21 Aim

The aim of this sample analysis is to see how the top part of the juicer behaves in service, and to see if it can be made from another material, for example a polymer. We will analyse the part to see the stresses and displacements experienced by the object as it is used.

2.22 Assumptions

One of the most important things to realise about the technique is that it is an approximate computational technique. Given the power and integration of modern applications, it is sometimes easy to forget this.

- For the sake of simplicity, we will just look at the top part of the juicer.
- We will assume that it is rigidly attached to the stand, and that this stand does not move.
- We will assume that the main load on this part is the downward force exerted by the juicer handle when in operation. We will ignore other forces.

2.23 Starting the Package

Open the component in Solid Edge, and you will see a Design Space 7 menu. Activate this menu and click on Start DesignSpace. You should see a window to the left of the screen called launch wizard. Click on “Choose Wizard” and choose the first option “Find safety factors, stresses and deformation”.

2.24 Opening the Part Geometry

You will now see a list in the same window called “required steps”. Click on the first of these “Insert Geometry”. At the top of the window, a list headed “Active CAD files” will be seen. Select the open part from this list. Wait as the part is imported. You should see the solid model appear in the main window within a few seconds.

The “required steps” window contains a list of the remaining steps - identify the material, add supports and loads, and specify which results you want to see. On the
left side, you will see a tree containing all model information so far inserted. At this stage, there will be a geometry object, and a mesh object. If you want to see the finite element mesh, click on this object.

2.25 Specifying Material

*ANSYS* contains a database of the properties of a selection of materials. We will use one of these, structural steel, for the properties (The required properties are Young’s modulus and Poisson’s ratio – these are fairly constant for most types of plain carbon and low alloy steel). Open the Engineering Data branch of the tree. You should find that structural steel has been set by default. Leave this for the moment.

2.26 Manipulating the Model

If you want to look at the model, you can use the following toolbar buttons, or you can right click with the mouse:

2.27 Adding Supports

Click on the step called “Insert Supports”. You will see two new items appear in the toolbar – “Structural” and “Thermal”. We will create a rigid support where the part joins to the stand. To do this, select Fixed Support from the Structural menu. Now click on the toolbar button which allows you to select a surface. Pick the cylindrical surface and click “Apply” in the window at the lower left corner. You have now restrained this entire surface so that it will not move.

2.28 Adding Loads

The load caused by the arm can be represented by applying a bolt load to the inner surface of the arm mounting. A bolt load simulates the loads transmitted by a bolt bearing down on the curved surface.

Click on the Structural menu, and select Bolt Load. Set the cursor to surface select mode, and pick the inner surface of the bolt mounting. Click apply. The direction now needs to be set. You can set the direction by selecting the “Direction | Click to change”
box, and selecting a surface which faces in the right direction. One of the flat surfaces at the bottom of the part will do.

If tick marks appear on the loads and supports in the upper left window, then you have fully specified them.

2.29 Selecting Results
Now, you click on the last part of the problem specification, Select Results. We are interested in how much the part will deflect, and what stresses are generated. Select all the stress components, and both the deflection components.

2.30 Look at the Mesh
Before you solve the problem, look at the mesh by right-clicking on the “mesh” option in the tree and selecting preview mesh. This will show the size and shape of the elements to be used. Understanding of the problem, and experience with the Finite Element method will be your guide as to whether this mesh will adequately represent the problem. If a mesh is too coarse, localised behaviour will be missed. If elements are too fine, solution time may be excessive. If the elements are badly shaped, inaccuracy may creep into the solution.

2.31 Solve the Problem
Now you are ready to solve the problem. To solve, click the Solve button on top toolbar (looks like a flash of lightning). The problem should take a couple of minutes to solve.

2.32 View the Results
You can now view the results you have previously selected. Simply select the appropriate stress or displacement results set in the tree, and the corresponding contour diagram will be shown.
### 2.33 Elasticity

Many materials used in engineering may be described as elastic. That is, they obey Hooke’s law in that they distort under load and the distortion is proportional to the load applied. This behaviour applies until some limiting point known as the elastic limit.

In order to understand the mechanical properties of materials under load, engineers use the terms stress and strain. Strain is the fractional change in dimension of a material due to an applied load. Stress is the amount of force per unit area of the material at a given point.

Consider the diagram above. A piece of material of cross-sectional area \( A \) is under a tensile load \( P \). Assuming that that load is carried uniformly across the area (true away from the ends of the object), then we can compute the average stress across the area. Again, away from the ends of the object, this average stress will be the same as the stress at any particular point. The stress, usually designated \( \sigma \), is computed as follows:

\[
\text{Force} = P \text{ N}, \quad \text{Area} = A \text{ m}^2 \quad \text{Stress} \sigma = \frac{P}{A} \text{ N m}^{-2}
\]

Strain is computed as \( \varepsilon = \frac{\Delta L}{L} \), and is dimensionless. Often, this number is of the order of \( 10^{-4} \), and may be written as \( \varepsilon = 100 \mu \), meaning \( 100 \times 10^{-6} \).

**Note:** that as load increases, cross-sectional area and length change, so that strains and stresses calculated with the original \( L \) and \( A \) are no longer strictly correct. Stresses and strains calculated in this manner are called *engineering* stresses and strains and are adequate for most materials and applications.

**Note:** also that the above example only considers loads applied in one direction, i.e. uniaxial stresses and strains. In two and three dimensions, stresses and strains become more complex and are in fact tensor quantities.
2.34 Stress and Strain and Elastic Behaviour

Stress and strain are related just as Load and Extension of springs in Hooke’s law. In the case of stress and strain, the “spring constant” is called Young’s Modulus and is usually denoted by $E$. Hence, we have the relationship:

$$\sigma = \varepsilon E$$

Elasticity

Many engineering materials exhibit linear elasticity. That is, stress is proportional to strain up to a limit. The properties of materials may be examined by performing a tensile test as follows: A sample of material is machined into a shape similar to that shown. It is clamped at both ends in a machine that can exert controlled loads on the sample. The strain of the centre section may be measured directly (using strain gauges) or indirectly by measuring the distance between two points on the narrow section. A range of loads is applied to the sample and the corresponding strains measured.

Stress may be plotted against strain to measure the Young’s modulus of the material. In the case of many engineering materials such as steels, the material exhibits elastic behaviour until a defined limit, called the *yield point* is reached. At this point, the material begins to permanently distort. This is useful in metal forming operations, but is obviously to be avoided in components in service.

Other materials behave differently—some alloy steels and nonferrous metals exhibit a curve which gradually flattens out as stress increases. Other materials, notably polymers, exhibit time-dependent and temperature-dependent behaviour which is highly non-linear.

2.35 Two-Dimensional Stress and Strain

We now generalise the strain-displacement and stress-strain relations to two dimensions. As well as tensile and compressive stresses, in two dimensions we have a new kind of stress, shearing stress, produced by opposing loads as shown:

We will now consider the stresses on a differential volume element, in two directions, $x$ and $y$. For this differential element, we assume that the stress is dependent on position, and that it changes linearly with position.

Direct stresses are denoted $\sigma_x$ and $\sigma_y$ respectively, while shear stress is denoted $\tau_{xy}$. Corresponding strains are denoted $\varepsilon_x$, $\varepsilon_y$ and $\gamma_{xy}$ respectively.
2.36 Strains and Displacement

If a structure undergoes displacement, that displacement field must obey certain conditions. First, the field must be single-valued, so that every point's displaced position may be computed uniquely. Second, it must be continuous – no voids or overlaps must occur in the material.

When the object shown across undergoes deformation, three distinct changes occur. The origin moves, the axes change their angular direction, and they stretch. From the diagram we can express the strains in terms of the displacements shown.

These relations can be written in three dimensions as follows:

\[ \varepsilon_x = \frac{\partial u}{\partial x} \quad \gamma_{xy} = \frac{\partial u}{\partial y} + \frac{\partial v}{\partial x} \]
\[ \varepsilon_y = \frac{\partial v}{\partial y} \quad \gamma_{yx} = \frac{\partial u}{\partial x} + \frac{\partial w}{\partial y} \]
\[ \varepsilon_z = \frac{\partial w}{\partial z} \quad \gamma_{yz} = \frac{\partial v}{\partial z} + \frac{\partial w}{\partial y} \]

2.37 Some Other Topics on Stress and Strain

Isotropy

We may write stress and strain vectors in three dimensions as:

\[ \{\sigma\} = \begin{bmatrix} \sigma_x & \sigma_y & \sigma_z & \tau_{xy} & \tau_{xz} & \tau_{yz} \end{bmatrix}^T \]
\[ \{\varepsilon\} = \begin{bmatrix} \varepsilon_x & \varepsilon_y & \varepsilon_z & \gamma_{xy} & \gamma_{xz} & \gamma_{yz} \end{bmatrix}^T \]

For these quantities, Hooke's law may be written

\[ \{\sigma\} = [E]\{\varepsilon\} \quad \text{or} \quad \{\sigma\} = [C]\{\varepsilon\} \quad \text{where} \quad [E] = [C]^{-1} \]

E is a matrix of material stiffnesses and C is a matrix of material compliances. E is often the symbol used for Young's modulus, a single number, but here it represents a symmetric 6x6 matrix. Depending on the way material properties vary with direction, these terms will take on different values.

Isotropic Materials

Isotropic materials are materials which behave the same way in each direction. That is, if we cut a test sample from a block of that material, it would behave the same way no matter which direction the sample lay in the block. Many materials, such as metals, glass, some plastics and concrete behave in this way.
Orthotropic Materials
Other materials have a preferred direction, in which mechanical properties are superior. If properties are different in one direction, the material is called orthotropic. Examples would include timber and metals which have been processed in certain ways.

Anisotropic Materials
Materials whose properties vary in every direction are known as anisotropic. A complete model for timber would be anisotropic because properties will be different in three directions: Along the grain, radially out across the grain and circumferentially.

In general, for isotropic materials, the material’s stiffness properties are commonly defined by three properties: Young’s Modulus (E), Poisson’s Ratio (ν) and the shear modulus (G). In fact, only two of these quantities are independent and the three are related by the formula $E = 2(1 + ν)G$.

The stiffness matrix for an isotropic material therefore looks like this:

$$[E] = \begin{bmatrix} (1 - ν)c & νc & νc & 0 & 0 & 0 \\ νc & (1 - ν)c & νc & 0 & 0 & 0 \\ νc & νc & (1 - ν)c & 0 & 0 & 0 \\ 0 & 0 & 0 & G & 0 & 0 \\ 0 & 0 & 0 & 0 & G & 0 \\ 0 & 0 & 0 & 0 & 0 & G \end{bmatrix}$$

where $c = \frac{E}{(1 + ν)(1 - 2ν)}$

2.38 Plane Strain
Plain strain is a condition where deformation in the z direction is zero and $u$ and $v$ are functions of $x$ and $y$ only. Therefore $ε_z = γ_{xz} = γ_{yz} = 0$. Note, however that $σ_z$ is not necessarily zero. A reduced version of the stress-strain relationship may be written for isotropic solids:

$$\begin{pmatrix} σ_x \\ σ_y \\ τ_{xy} \end{pmatrix} = \frac{E}{(1 + ν)(1 - 2ν)} \begin{pmatrix} 1 - ν & ν & 0 \\ ν & 1 - ν & 0 \\ 0 & 0 & 1 - 2ν \end{pmatrix} \begin{pmatrix} ε_x \\ ε_y \\ γ_{xy} \end{pmatrix}$$

An example of plane strain conditions would be a cross-sectional slice of a tunnel along the z axis. Stress generated in the z direction may be computed from the following:

$$ε_z = (σ_z - νσ_y - νσ_x)/E = 0.$$
2.39 Plane Stress

Plane stress conditions occur in flat plates lying in and loaded in the $x$ and $y$ directions with no $z$ direction restraint, so that $\sigma_z = \tau_{zy} = \tau_{zx} = 0$. For Isotropic and Isothermal conditions,

\[
\begin{bmatrix}
\sigma_x \\
\sigma_y \\
\tau_{xy}
\end{bmatrix} = \frac{E}{1-\nu^2}
\begin{bmatrix}
1 & \nu & 0 \\
\nu & 1 & 0 \\
0 & 0 & \frac{1-\nu}{2}
\end{bmatrix}
\begin{bmatrix}
\varepsilon_x \\
\varepsilon_y \\
\gamma_{xy}
\end{bmatrix}
\]

or

\[
\begin{bmatrix}
\varepsilon_x \\
\varepsilon_y \\
\gamma_{xy}
\end{bmatrix} = \frac{1}{E}
\begin{bmatrix}
1 & -\nu & 0 \\
-\nu & 1 & 0 \\
0 & 0 & \frac{E}{G}
\end{bmatrix}
\begin{bmatrix}
\sigma_x \\
\sigma_y \\
\tau_{xy}
\end{bmatrix}
\]

Note: The above conditions of plane stress and plane strain only occur if $x$ and $y$ properties are the same. That is, if the material is orthotropic, then the different properties must lie along the $z$ direction.

2.40 Initial and Thermal Stress

Initial stress is a stress present before deformations are allowed. Initial strains are strains present before loads are applied. If both these quantities are present, then the stress-strain equation may be written:

\[
\{\sigma\} = [E](\{\varepsilon\} - \{\varepsilon_0\}) + \{\sigma_0\}
\]

where the subscript $0$ denotes initial quantities. Typical quantities modelled by initial stresses and strains are moisture-induced swelling and thermal expansion. Many of these effects can be included either as initial stress or initial strain quantities.

2.41 Thermal Expansion

Thermal expansion of a material is usually measured relative to some temperature considered the reference temperature, at which temperature strain and stress are assumed to be zero. Free expansion of an orthotropic material will therefore produce the following initial strains:

\[
\{\varepsilon_0\} = [\alpha_x T \quad \alpha_y T \quad \alpha_z T \quad 0 \quad 0 \quad 0]^T
\]

This can also be expressed in terms of initial stress. If the material is also isotropic then we can write:

\[
\{\sigma_0\} = \frac{E\alpha T}{1-2\nu} [1 \quad 1 \quad 0 \quad 0 \quad 0]^T
\]

In plane stress and plane strain situations, we have the following expressions:

- **plane stress**: \[
\{\varepsilon_0\} = [\alpha T \quad \alpha T \quad 0]^T \; ; \; \{\sigma_0\} = \frac{E\alpha T}{1-\nu} [1 \quad 1 \quad 0]^T
\]

- **plane strain**: \[
\{\varepsilon_0\} = (1+\nu)[\alpha T \quad \alpha T \quad 0]^T \; ; \; \{\sigma_0\} = \frac{E\alpha T}{1-2\nu} [1 \quad 1 \quad 0]^T
\]
Often, the temperature coefficient of expansion is itself temperature dependent, and we must take this into account:

\[ \varepsilon = \int \alpha \,dT = \bar{\alpha}T \quad \text{where} \quad \bar{\alpha} = \frac{1}{T} \int \alpha \,dT \]

Often, other quantities can be temperature-dependent. In such cases, the values can typically be entered into a FEM package in tabular form.
Days 3&4: Visualisation (9 hours)

Stills
Animations
In this module we will use Photoshop to prepare texture maps to be used in the rendering process. Rendering is the process of colouring and shading a graphic object (normally wireframe) so that it looks solid and real (photorealistic). We will create a brushed steel and a marble texture map in Photoshop. These are later imported into 3D Studio and rendered for on-screen visualisation. The on-screen model component will look like it has been finished in brushed steel standing on a marble counter.

3.1 The Photoshop Workspace

When you open Photoshop, it will display the workspace as shown. Generally there are 6 components as follows:
1. The Menu bar
2. The Options bar
3. The Drawing canvas/ Document window
4. The Toolbox
5. The Palettes (3 of them by default)
6. The Status bar
Photoshop is a sophisticated image-editing application. You can use it to alter images like photos, downloaded icons, or scanned work. Altering an image includes doing such things as changing the colours within an image, modifying the size and scale of an image, or putting one picture within another. Alteration also includes technical modifications such as changing the mode of image compression from one type to another, or changing the number of bits used per pixel. In addition Photoshop has many tools to help you create an image from scratch.

3.2 The Photoshop Toolbox

The toolbox usually floats on the left side of the screen. It holds up to 51 tools that allow you to paint, select, navigate and edit images. To select a tool you simply click on the icon with your mouse. You will notice the cursor pointer changes accordingly. Some of these tools contain more choices, indicated by a small black triangle in the lower right hand corner of the tool. To view or use these Tools, left click on the Tool and hold, then select the required Tool. Notice too that the look of the Options bar will also change depending on which tool is active. You can also use keyboard shortcuts to access these tools (See the graphic for a list of some keyboard shortcuts for the tools). If you’re not sure what the icon for a tool represents, simply move your cursor over it (without clicking) and a pop-up tab will appear with the tool’s name and its keyboard shortcut. If you’d like Photoshop to remind you of the name of the tool that’s currently selected, click on the right-facing triangle on the status bar (at the bottom of the screen) and select Current Tool. Photoshop will then display the name of the current tool in the status bar.

3.3 The Palettes

Palettes help you define the nature of your tools and to customize how they perform. For example, you might want to `sharpen` your pencil tool (make the line thin) or `dull` (make the line thick) using the Brushes Palette. Palettes also help you perform some of the more complex tasks like layering, or manipulating complex colour schemes. On each palette, you will see several tabs. By clicking on the name of a tab, you can bring that palette "forward" (like a Rolodex card). The various tabs present a variety of features you may want to use in editing your images. If you’d like to get some of the other tabs out of your way, you can do so using the Palette Well in the upper right-hand corner of the screen. The palette well stores individual tabs that you don’t need to access very often so that they’re not taking up room on your desktop. To move a tab into the well, click on the tab name, drag it over the palette well, then drop it.

Note: that you can only drag individual tabs into the well; you cannot drag whole palettes. To access a palette in the well, simply click on its tab name. If you no longer
want a palette to be housed in the well, either click and drag it out or if you'd like to see the floating palettes in their default arrangement, choose the **Window** command from the menu bar, then select **Reset Palette Locations**.

By default 3 floating Palettes appear when you open *Photoshop*. These can contain all 10 palettes available through the **Window** menu. The Window sample below shows all 10 palettes. The various palettes are available in the floating palettes through tab selections as shown in the floating palette sample below on the right.

Though these 3 palettes control many different aspects of your drawing, they do share several properties. For one, all palettes are made up of a title bar with collapse and close buttons, a set of tabs, and a list of options for each tab. Additionally, all palettes have a fly-out menu of options obtained by clicking on the black triangle. Another generic property of palettes is the ability to customize their tabs and move them to other palettes. Finally, if you 'lose' a palette by closing it, you can easily get it back on screen by choosing it from the **Window** menu.

**Figure** shows the Window menu for displaying and hiding various palettes, the Info Palette for Pixel description, the Colour Palette, the Layers Menu showing three layers and the Layers flyout menu accessed by clicking on the right facing arrow.
3.4 Preparing Maps for the Rendering Engine in 3D Studio

Examples of some environment maps:

- brushed gold.jpg
- sunset.jpg
- fluorescent tube.bmp

3.4.1 Brushed Steel

Open the *Photoshop* program, version 6. Use the **File** | **New** command to create a new file. You will be asked to select size of format etc. Input the following:

- **Name:** Brushed Steel
- **Image size:** 1 inch x 1 inch
- **Resolution:** 72 pixels/inch
- **Mode:** RGB Color
- **Contents:** White

Hit **Ok**.

As you can see Resolution has a direct result on the file size. For images that do not look too pixellated you should choose a higher Resolution, but the desire here is to keep the file size down.

Go to the Toolbox and select the **Foreground** colour. The colour picker appears, select a light grey colour. Now use the **Paint Bucket Tool** from the Toolbox to paint a light colour of grey into the white canvas. If the tool is not immediately obvious, it could be hidden underneath the Gradient tool, located to the right of the Eraser tool. Select it and dump the grey colour onto the white canvas.

Go to **Filter** | **Noise** | **Add Noise**... menu and input as shown:
- **Amount** 20.85%; Tick the monochromatic box.
Now select Filter| Blur| Motion Blur from the menu. Input the desired amount of blur as shown...Angle: 0, Distance: 10 pixels.

Select Image| Adjust| Brightness/ Contrast... from the menu. Brightness: -20; Contrast: +30. Hit Ok.

Select File| Save as
Save the file as a bmp, jpeg or png.

If you make a mistake use the History Palette to undo. While you can use the Edit, Undo command to undo the last change you made to your image, Photoshop, unlike Microsoft programs such as Word, does not offer a "multiple undo" feature on the menu bar. The History palette displays the last 20 steps, or "states," you've made in editing your document. To undo the very last thing you did, simply click on the name of the state preceding the one that's currently selected in your History palette. To undo several steps at a time, click on the description of an editing state several states above the one that's currently selected. You should see that several editing changes were undone at once.

3.4.2 Marble

Use the File| New command to create a new file. Input the following:
Name: Marble, Image size: 1 inch x 1 inch, Resolution: 72 pixels/inch, Mode: RGB Color, Contents: White. Hit Ok.

Go to the Toolbox and reset to the default Foreground and Background Colours by clicking on the miniature on the lower left hand side.
Go to Filter| Render| Difference Clouds. To reapply this filter a couple of times hit Ctrl+F four times.
If your image doesn’t look exactly like mine don’t worry, the *Difference Clouds* filter comes out different every time.

Move on to **Filter > Stylize > Find Edges** and the **Image > Adjust > Invert** (Ctrl+I).

Next up is **Image > Adjust > Levels** (Ctrl+L), set the dialog to something like I did below. Keep your own image visible while you set the dialog.

![Image Adjust Levels](image)

Go to **Image > Adjust > Brightness/Contrast**... Set the Brightness slider to +20.

To colour your texture use **Image > Adjust > Hue/Saturation** (Ctrl+U). Check the *Colorize* box and move the Hue and Saturation sliders around until you are satisfied.

The settings I used were:

- **Hue:** 220
- **Saturation:** 25
- **Lightness:** 0

This gives a realistic marble texture map with a slightly blueish tinge.

**Hue:**
A term used to describe the entire range of colours of the spectrum; hue is the component that determines just what colour you are using. In gradients, when you use a colour model in which hue is a component, you can create rainbow effects.

**Saturation:**
Designates the purity of a colour or how much the colour is diluted by white. Red is a highly saturated colour. Pink has the same hue but a lower saturation.

If you make a mistake use the **History Palette** to undo.

Select **File > Save as**
Save the file as a *bmp, jpeg* or *png.*
3.5 Saving Images and File Types

Photoshop allows you to save your images in a variety of file types. You can usually change the file type by selecting Save As from the File menu and selecting a file type from the Save As drop-down menu. (If you have layers in your image, you will have to select Save a Copy from the File menu). Some common file types:

- **Photoshop (.psd):** If you want to save any layers that you've created in an image, this is your best choice; most other formats will discard any layer information. In addition, Photoshop format compresses images when it saves them so they take up no more disk space than absolutely necessary. The compression is lossless - not one pixel in the image is removed or changed when the image is reloaded. The disadvantages to this format are that the file size tends to be large, and that other applications will not be able to open this type of file. It's usually a good idea to save an image in .psd format until you're finished with the editing process, then save it in a format appropriate to its output use.

- **JPEG (.jpg):** Joint Photographic Experts Group. JPEGs use a lossy method of file compression; in other words, every time you save an image in JPEG format, you lose more image data. You should edit your images in another format and then save them as JPEGs when you are through editing. Because their file size is relatively small, JPEGs are useful for the web. Your image must be in RGB, Grayscale or CMYK mode in order to be saved in JPEG format.

- **GIF and GIF89a (.gif):** Gif and Gif89a save images in only 256 colours (Indexed Color mode), which keeps the file size down, so this file type is very useful on the web. Usually, you will use JPEGs for photographs, since that file type supports millions of colours, and Gifs for all other web images. Gif89a allows transparencies, interlacing, and animations. To save an image as Gif89a file, you must select Export from the File menu and then Gif89a.
In this module we will be using 3D Studio Max to animate the model showing the movement of the lever-arm, the attached cog and the ratchet bar. We will start by meshing the model of the ratchet housing within Rhinoceros. This will be imported into 3D Studio Max as a .3ds file, which is the native file type of the program. The complete model of the juice expresser - containing all the remaining parts - will be supplied during class as a .3ds file.

3.6 Meshing the Model in Rhinoceros

Let's start off by first opening the Rhinoceros program. We will now attempt to mesh the previously created NURB geometry of the gear housing.

The above screen shot shows the NURB geometry or the NURB mesh. The next screen shot shows the NURB mesh after it has been converted to a Polygon mesh. Both meshes are visible. This is in fact the only way of transferring data from Rhinoceros to 3D Studio Max.

From the menu select Tools| Polygon Mesh| From NURBS Object.
Adjusting the mesh density with the slider.

The Polygon Mesh Options window opens. The slider will allow you to adjust the meshing of the model to achieve the desired mesh density. This will vary depending on the model complexity. For example a simple box geometry is made up of flat sides and therefore would need a very low setting on the slider. On the other hand a curved object similar to the part we will be meshing is complex and therefore needs a higher setting on the slider to achieve a more dense mesh. The dense mesh will create a smooth model.

A Low mesh density  
A Higher mesh density

Now that we have created a well-packed but not very dense mesh we can save out of Rhinoceros to export into 3D Studio Max or Viz.
Once we have created the Polygon mesh, we can delete or hide the NURB mesh to view the quality of the polygon mesh surface.

The smooth surface shown left is the result of a dense setting in the polygon mesh slider we looked at. You can see that the surfaces are nice and rounded and there are no bad surfaces visible. These are known as artifacts. The next screenshot below left shows you a model with a badly formed Polygon Surface. Notice the low detail of the mesh in the corresponding screenshot below right.

When you are happy with the surface density of your model, you can proceed to save it as a .3ds file for 3D Studio or the other alternative is to save as an IGES file and select either the default setting or the 3ds setting. This can be flavoured to whatever version you are working with. We will choose this latter option.

Select: File| Export Selected.
Save your file as a IGES format in the 3ds 3.0 flavour to the allocated disk space.
3.7 Importing the Model into 3D Studio

Open 3D Studio Max and import the polygon mesh file into the program.

We previously saved our gear-housing file as 3ds.

From the menu select: File | Import File Selection.

You will be asked to merge your file with the current file, or completely replace the current scene, in this case just choose the default setting.

Individual parts of your model can be selected via the selection floater. This lists all the individual parts that make up the model.

From the menu select: Tools | Selection Floater
The screen shot shows the full assembly of all the parts which make up the juice expresser. The full model will be supplied in class.

The model has been imported using the IGES format in the 3ds 3.0 flavour. When your file is situated in the program’s workspace, you can start to select various parts. You might find that they have been grouped together into one or two layers, so this has to be addressed first. This is another reason to make polygon meshes of each part of your model before importing into 3D Studio, because they will be listed as individual parts in the selection floater, therefore saving time. The next step is to go to the Utility panel and select the display icon on the right side menu and switch on the following buttons:

- Tick the material color setting for the wire-frame and just below that select the material color setting for the shaded mode. At this stage it will make it easier for you to navigate the interface and your model. Later on as you become more familiar with the interface you can assign each part a colour.
The next issue to address is how to move objects around the workspace. The screenshot below shows one of the main panels for moving and swivelling your model in 3D space. By selecting this icon you will see your model swivel.

At this stage go to the selection floater and select all the parts, 1-20 or more. Now go to the Left view-port and right click on your mouse. Select the move tab and move the whole model to the centre of the grid. The model is now sitting on top of the grid, as shown below.

3.8 Setting Up Cameras & Lights

Now that our model is correctly located, it can be viewed clearly in the centre of the workspace. We will start now to set up the cameras & lights. Go to the Utility panel and select the camera icon. Now select the target tab from the panel and go to the Left view-port and click near the model. Hold down the mouse key and drag until the viewing angle for the camera appears. At this stage you can now view through the camera and see what direction you are looking toward.

You can also use the lower panel, which contains the swivel button, to control the movements of the camera. Note that the panel will change icons when you select the camera. To change the standard Perspective view port to a Camera view port just type C on the keyboard. A dialog box should appear. Select the camera and see the view change.
We will now add some lighting by clicking on the **Light** icon on the Utility panel. Icons such as **spot light** and **omni light** are the basic types of lights available to light the model.

Select the **target spot** tab and again click in the **left view-port** and drag until the light cone expands. When the light is installed the model will illuminate in the view port only if the setting has been set to shade the model. Just right click on the **camera** or **perspective** tab to see this menu.

---

### 3.9 Applying Texture Maps and Shading

Now we are ready to look at applying textures to the whole model, or to individual parts. Go to the **Selection floater** and select a part you want to apply a texture too.

**Note:** You can also click on the part if you only have a few, and select it manually. Zoom in on the part by using the roller on the mouse.
Now open the materials editor by selecting its icon and then click on a sphere. For our purposes we will pull the brushed steel texture map, created earlier, into the materials editor by using the diffuse tab - see screen shot below. The diffuse setting is the basic setting for attaching photos, or other bitmaps to the 3D geometry in 3D Studio. Once the photo is attached to the sphere in the materials editor we simply assign it to a part.

Now use the shade or render button to get a rendering or a Bitmap image.
3.10 Setting Up the Animation

Now with our model set up, and our parts renamed for easy selection, we can proceed to set up the **links** between objects.

What do I mean by links between objects?

Each part in our model is physically touching or linked to the next component in our juice expresser model. By specifying, for example that the handle or lever is connected to the gear cog and so forth, we are then able to set up relationships between various pieces of the juicer. The term used in the Animation industry for such a link is the **Parent & child relationship**.

With the introduction to the concept of the parent & child relationship we also discover the principle use for having a **Hierarchy**. So now we can start to understand the principles and terminologies involved in setting up our model for animation control and make it move in the desired fashion.

![Image of model with hierarchy menu]

**Linking one component to the next.**

Start this exercise by selecting the Lever. It is shown above with a white selection box around it. Use the hierarchy menu on the right of the screen to set up the pivot of the lever, the point around which it will turn. Ensure it is in the centre of the object as shown below with the green, blue and red arrow cluster.
After the hierarchy has been set up simply switch on the animation button. This appears in red when active signifying that it is recording the timings and movement which you have created within your model. You also have the option of setting the number of frames recorded by clicking on the key icon, the time configuration key. This controls the number of frames per second.
Now all we have to do is press the replay button to see the lever move up and down. Repeat this process with the remaining parts to create an even more complex animation.

Select File | Save as
Save the file as *Juicer.avi*
In this module we will use *ImageReady* to create stills that are blended into a professional looking gif animation. This acts as a 'light animation' that could then be emailed to a client. A more complex animation (and heavier file) will be created in *3D Studio* to show the model in operation. Both display what is still a virtual-model in a photorealistic way.

### 4.1 Taking a Screenshot and Cutting Away Areas of an Image

Take a screenshot of the model with its chrome environment map in the *3D Visual* application window. Switch to *ImageReady*. Hit Ctrl +N for a new image and then hit Ctrl +V to paste the screenshot image.

I have done this already and saved the file as *juicer.jpg*. Open the image.

We want to remove the outer edges of the image and just retain the model part. To do this we use the **Polygonal lasso tool**.

- First do a rough selection. Select the lasso tool from the Toolbox, then click and roughly select points around the area you want to retain. When you have finished the selection the cursor changes to a closing circle. Click to complete the selection. Choose Edit | Copy from the menu, and paste to a new layer. Select New Layer from the Flyout Layers menu. Make this layer the active layer and choose Edit | Paste from the menu.
- Switch off the first layer and work with this second layer. Right-click on the Layer and select Duplicate Layer. Now continue to work on this third Layer. Use the zoom-in tool to zoom-in on the pixels just under the lever arm. Select an area with the lasso tool and hit delete.

This technique of making individual Layers is especially useful if working on laborious images that need to be very precise. You can operate piecemeal, save your file and re-open it at a later date. This way you can return to the image at various stages and dump the Layer if you make a mistake.

- Now to remove the pixels around the edge of the juicer. Choose the Eraser tool and Increase and decrease the Brush size as necessary. Use Ctrl|+ to zoom-in or Ctrl | - to zoom-out.
- Rename the layer as *juicer!

If you make a mistake use the History Palette to undo.
4.2 Using Layers

Use File|Open to open the kitchen.psd image. Make sure the Layers Palette is active - if not bring it up via the Windows menu. Now reselect the juicer/ Layer. Make its layer active by clicking on its thumbnail and then drag and drop it into the kitchen.psd image you just opened. A new layer should appear in the kitchen.psd layer palette. You may need to resize the image using Edit|Transform|Scale and also to change the way it looks using various methods from the Transform menu such as Rotate, Skew, Distort, Perspective, Flip.

Right-click on the juicer/ Layer and select Duplicate Layer. Now Double-click on this layer to open the Layers Options dialog box and rename it juicer2. Repeat this process by creating layers called juicer3, juicer4 and juicer5. Also rename the background layer as kitchen1.

Make juicer/ the active layer and adjust its opacity slider to 10%. Repeat for the other layers: juicer2 with an opacity of 20%, juicer3 with an opacity of 40%, juicer4 with an opacity of 50%, and juicer5 with an opacity of 100%.

Use File|Open to open the dit.gif image. Make its layer active, click on the layer thumbnail and then drag and drop it into the kitchen.psd image. Rename the layer as dit. Scale down its size and place it in the top left corner of the canvas.

Opacity works on a scale of 0 to 100. If the Opacity is 100%, then the active layer will cover everything underneath it; if it’s lower than 100%, you will be able to see some of the layer below through your active layer. You can control the Opacity by clicking on the right-facing arrow and sliding the cursor to the appropriate setting, or by selecting the number in the box and typing a number from 0 to 100, then hitting Enter.

4.3 Using the Type Tool to Create Text Layers

Select the Text tool from the Toolbox. From the Options bar, make the following adjustments:
Font: Century; Size: 36pt; Anti-Aliasing Method: Strong; Text color: Blue 1A7ED5

Click and drag a box in the canvas area. Try typing the sample text:
3D Digital with ProtoTyping
Presented by Staff Training & Development

A text layer will appear in the Layers Palette. Use the select button to nudge the text to near the top of the overall image.

Repeat by creating another text Layer with:
17th to 21st May, Bolton St.

Hit Ctrl +A to select all the text inside the text area and from the Options bar, adjust the Text colour to red:
Use the select button to nudge the text to near the middle of the overall image.

Add another text Layer with:
Book Online At...

Hit Ctrl +A to select all the text inside the text area and from the Options bar, adjust the Text colour to green:

At this stage you have all the Layers created. A good tip at this point is to save the file. That way if you decide to make changes later you have this initial version to call up.

Select File|Save as Save the file as JuicerInitial.psd
4.4 Merging Layers to Make Stills

Make sure the Layers Palette is active - if not bring it up via the Windows menu. The animation will be made up of 5 Frames. Each frame has a base frame of the kitchen1 layer, the dit layer and the 3 Text layers.

- Switch these layers on while keeping the others off. Do this by unclicking the eye button for each layer you want off until only the required layers are visible.
- Now make the kitchen1 layer active. From the Flyout Layers menu select Merge Visible. Notice this new layer keeps the name kitchen1, the name of the active layer.
- Now make some duplicates of the kitchen1 layer by selecting Duplicate Layer in the Flyout Layers menu. Rename the layers kitchen2, kitchen3, kitchen4 and kitchen5.
- Switch off all layers except the kitchen1 layer and the juicer1 layer. Make the kitchen1 layer the active layer. From the Flyout Layers menu select Merge Visible. Switch off all layers except the kitchen2 layer and the juicer2 layer. Make the kitchen2 layer the active layer. From the Flyout Layers menu select Merge Visible etc.

4.5 Setting the Timings for the Animated Gif

Make sure the Animation Palette is active - if not bring it up via the Windows menu. Select the Make Frames from Layers option from the fly-out menu on the Animation Palette. All the layers should now appear as frames in the Animation Window. Set the timings, whether you want it to loop once or forever (the loop count), or to add any tweening, e.g. if one still is particularly noteworthy, you can increase its delay by up to 240s (the highest setting).

I used timings of 0.5s for the first four frames and 1.5s for frame five. Click on the play button to run the animation and get an idea of how it will play. Set the animation to loop forever.

If the Optimize window is not set for a Gif then set it now. Select File| Save Optimized as to save the file as a gif animation. Save as juicer.gif.

If you click on the Preview Tool you will see your animation running in the default browser. It is too large, so return to ImageReady and reduce the overall image size using Image| Image Size ... I used a width setting of 400 pixels. This way, if you view the animation in a browser or send it as an attachment, the image is a more satisfactory viewing size.

By keeping a copy in .psd format you keep the option of changing the frame timings at a later date, if so desired. Also it can be a good idea to save a copy in .psd format
before you flatten the layers in case you decide to change more than the frame timings at a later date.

Figures show:
(a) The layers in the initial stages before duplicates are made of the kitchen1 layer,
(b) The text layers have been merged with the kitchen1 layer and then duplicates made,
(c) The Juicer4 Layer being dragged and dropped into the correct Stack position above the kitchen4 layer,
(d) The Merge Visible command about to be applied to the kitchen1 layer and the juicer1 layer.
Day 5: Manufacture (2 hours)
Presentation (6 hours)
In this module using DeskProto we will import the 3D solid model of the juicer-part created using Rhinoceros and print it out in balsa wood. DeskProto takes the model geometry and writes an NC toolpath file. This file is interpreted by the CNC machine’s control-software and determines which paths the toolhead will move along. But first a short introduction on the history of 3D printing.

5.1 Introduction
3D printers have been around for a few years, but until recently the process has been far too expensive for the average person to have a model printed. An entry level ProtoTyping unit, such as Z Corporation’s ZPrinter 310 System, currently costs $31,800 but it can be very affordable to send your digital model to a Service Bureau costing as little as €40.

Why print?
Industrial designers might want to prototype their design to look for possible flaws that are hard to see on the computer screen. Convincing a client of a new design is easier if the model can be hand-held. If you want to go into production you need to create a master mould or cast. Alternatively if you just want to create functional end-user parts you can create the prototype yourself - especially if the parts are difficult to find.

5.2 A Brief History of 3D Printing
CNC milling machines were developed based on conventional milling machines, where the tool was moved through the material by operating a hand wheel for each of the available axes (X, Y, Z,...). When NC (Numerical Control) arrived in the early 1950’s it replaced the hand wheel by a positioning motor and added some electronics (the NC controller) to control the position. The first NC controllers were very basic. They had no user-interface, just an option to read the tool-positions to go to from a punched tape. Very soon new controllers were introduced, including a simple computer with a special-purpose keyboard and a display. The operator could now enter the sequence of movements to be made (the NC program) on the controller. Thus was born CNC (Computerized Numerical Control). In some cases a tape puncher / reader was still available for external storage.

The next step was to use a PC for external storage. The PC communicated with the CNC controller via a serial cable. This allowed the operator to conveniently sit at his desk to enter a new NC program, while at the same time the CNC machine was executing a previous job. In this situation the operator entered the complete NC
program on the computer using a plain editor like Notepad or a special purpose NC editor. Each movement had to be separately entered, like "G0X10Y20Z30" for "Machine in a straight line from the current position to position (10,20,30)". This was of course very labour intensive, and this is where CAM software entered to 'automatically' generate NC program files.

5.3 How 3D Printing Works
In order to manufacture a part nowadays, typically three different software programs are used:

1. First the CAD software makes the design of the part – the geometry file.
2. Second the CAM software calculates the toolpaths based on the design, compensating for the cutter’s geometry, adding feedrate and spindle commands, etc.
3. Third the CNC machine's control software reads the toolpaths to interpret what paths the tools will move along.

This subdivision of tasks by three different programs is the same for both 2D and 3D applications. The Control software comes with the milling machine, while in contrast the CAD (Rhinoceros) and the CAM (DeskProto) software have to be bought separately. In case an NC controller with built in special purpose computer is used, the Control software is integrated. In case of a PC the Control software has to be installed, still it "belongs" to the machine as the machine cannot function without the Control software. Many lowcost CNC machines are delivered with MS Dos based Control software, as the realtime control needed for machining is difficult to program under Windows.

5.4 File Formats used in 3D Printing
Communication between the three programs is done using various file formats. From CAD to CAM the design is transferred using a file format for geometry data exchange. For instance file types like IGES, STL and STEP for 3D, DXF for both 2D and 3D, and Postscript and HPGL for 2D applications. These are standard formats that in most (!) cases can be used without any special configuring needed. Much more can be said about these file types.

Communication from CAM to Control software is done using NC program files, for which many formats exist. In most cases the format will be a (minor) variation on the ISO / DIN G-code format. G-code is supposed to be a standard, however in practice each manufacturer chooses an implementation that is a bit different. In other cases a proprietary format is used. So for this communication the CAM software has to fine tune its output in order to meet the requirements of the NC controller used. This fine tuning is done by the Postprocessor.

The Postprocessor is the part of the CAM software that translates the toolpath data into the correct file format when saving (in fact an export filter). This functionality is the same as used in the (Windows) device driver that comes with any
printer, to translate the wordprocessor's output to the format required by that printer. In many current CAM systems the postprocessor can be configured by the user, making it easy to connect to any new machine. This is in contrast to the older CAM packages where the user has to pay the supplier to order a new postprocessor. In some specific situations one of the three programs just described (CAD-CAM-Control) may be omitted. For instance some machines can be used without control software (like the small Roland models, where a plain "print" command is sufficient to start the machine). Or in some setups a plot file (or even a 2D DXF file) from the CAD system can be immediately sent to the control software, skipping the CAM step. Still it makes sense to distinguish the 3 basic steps, for a clear picture of the process involved.

On-line machining means the capability of handling large NC program files directly from the computer's hard disk. This involves some handshaking between the PC and the controller, as in most cases the data transfer will be faster than the actual machining. No big deal: any simple printer can do so. However many older CNC machines cannot: they have been designed for NC programs that are completely entered by hand, so they consider a 100 KB NC program file as very large. For CAM this is not large: it is easy to create 10 MB NC programs, or even larger. Those older machines require the complete NC program file to be transferred before the machining can start, limiting the file size to the (say) 256 KB of available internal memory. The option of on-line machining is also called drip-feed, or DNC (for Direct Numerical Control).

5.5 3D Printing Resources in D.I.T.

At present DIT has equipment in various faculties which could be used to manufacture parts, to create a digitally produced prototype.

- Construction Technology & Management, Linen hall has a 4-axis CNC machine which can produce models imported in IGES format. The system runs on AlphaCAM.
- Computer Aided Manufacturing, Room 181, Bolton St. have a Cincinnati Milacron Arrow 500 machine. The system also runs on AlphaCAM.
- Architecture, Room 417, Bolton St. use the ISEL 4030 model running on DeskProto. We will use this system.

![Construction Tech. & Man.](image1)  ![Computer Aided Manufacturing](image2)  ![Architecture](image3)

5.6 Printing the 3D Model

Generally a model is created in AutoCAD, Pro Engineer or Rhino and saved as a .STL file before being imported into DeskProto. DeskProto is now integrated with Rhino using a Plug-in. Using this plug-in DeskProto can be started from Rhino, and it will automatically load your current Rhino geometry into the CAM software package by just clicking the DP button in Rhino or from the menu selecting:
File| Print 3D| Delft Spline Systems DeskProto. The plugin can be downloaded free of charge. It requires both Rhino version 3 and DeskProto on your PC, otherwise installation is not possible. Download the file "RhinoProto.zip" (18 Kb) from www.deskproto.com
A 30 day trial version of DeskProto 3 can also be downloaded for free.

Figure shows David's laptop open in its Rhino window on the right hand side and to the left the Kay Control program window attached to the CNC machine with the imported G-Code file about to be run.

Step 1 Model geometry shown in the Rhino window.
**Step 2** Sending the model to the 3D printer.

**Step 3** The .STL file is created automatically. Input a Tolerance of 0.01mm for the mesh.
Step 4 The program meshes the file.

Step 5 DeskProto opens automatically and runs the DeskProto Wizard. Hit Next as the default setting of Basic Milling is correct. In the next dialog window you are prompted to Load the geometry file.

Step 6 Setup the model for cutting-G codes. The next step of the Wizard asks for input values for the x-axis, y-axis, z-axis, Rotation values. The cutter will act parallel to the z-axis so changing these values change the orientation of the cut.
Click the **Load geometry** button. In the next dialog window you select the correct geometry file from the **Data** folder. This is where **DeskProto** stores all files by default. Select the correct .STL file and hit **Open**.

Hit **Next**. Specify if you want to mill full size or a scaled up or scaled down version of the model.
Now that your geometry is correctly oriented, you may need to scale. The part should fit in the working area of your machine.

Check the dimensions of your part in the Geometry Info Dialog box (part tab) that just popped up.

**Scale**

- **X axis**: 
- **Y axis**: 
- **Z axis**: 

- **Uniform Scaling**

---

Now specify the segment: the part of the geometry you wish to cut. The segment is shown as a green rectangle, by default the bounding box around your geometry.

**Settings for the segment**

- Use whole geometry
- Use upper half of geometry
- Custom

**Minimum**

- **X**: 4.53 mm
- **Y**: -14.26 mm
- **Z**: 26.91 mm

**Maximum**

- **X**: 90.20 mm
- **Y**: 14.26 mm
- **Z**: 26.91 mm

Upon pressing next, the validity of the segment will be verified. In case of an error, adjust the rotation, scaling or segmentation.
Select the Ball nose, radius 3 = diameter 6 mm.
Click on the **Calculate Toolpaths** button. A graphical representation of the model is displayed, showing the area to be cut away in red and the model in blue.
The NC program file contains the toolpath information in a format suitable for your machine.

Press the button to create the NC program file.

After finishing this wizard you can still fine-tune any parameter setting for the new part. You can even add operations. Do not forget to write the NC program again after any change.

Write NC program file

Cut your material block to be at least

\[(X,Y,Z) = (65.67, 28.51, 53.83) \text{ mm.}\]

The top-left-front corner of the block should be set to be the workpiece zero point.

File name: gear housing

Save as type: NC-Program-files (*.ncp)
Step 7 Bring the G-Code file into the Kay program and set up. Move the Toolhead in the x and y directions by clicking the directional buttons on the wheel and in the z direction by clicking the up and down arrows. Set the origin at the edge of the balsa block. Once you are satisfied click the Memorise button. If you later move the head you can reset by clicking on Drive to and it will bring the Toolhead back to your set and saved position. Adjust the speed if you want to move the Toolhead slower or faster into position. Now click on the Start Machining button.

Figure shows left, the origin being set, middle, the model being milled, right, the finished model.

5.7 Typical Materials used in 3D Printing
- Transparent Perspex to simulate glass e.g. perfume bottle
- Solid blocks of balsa wood or mdf.
- ‘Cibatool’ (inside the USA called ‘Renshape’), This is a ‘wood-like’ model material, e.g. to make moulds in the canning industry.
- PUR (PolyURethane) foam, e.g. to make moulds for the Packaging industry and to create aluminium sheets via the lost foam method.
- Metapor - a micro-porous, ‘air permeable’ type of aluminium. This is especially suited for thermoforming as no small air ducts have to be drilled. The prototype milled from metapor is used to make a plastic mould, e.g. to make moulds for chocolate bars.
- Stone, pure white Carrara Marble and plaster e.g. sculpturing art.
- Wax. e.g. to make the moulds for casting in the jewellery trade via the lost wax method.
- Tool steel. e.g. to make the cavity in a production mould for the silicone mouthpiece of a flexible plastic bottle used by athletes.

A presentation will be given on various case studies outlining examples of the above.
5.8 Future Aims- Reverse Engineering

Another area that the course may move into is the teaching of reverse engineering techniques combined with rapid prototyping. A Microscribe 3D Digitising arm is presently located in Advanced Manufacturing, Room 101, DIT Bolton St. The arm, shown right, works by tracing over the contours of a physical object and can build a complex 3D model in a matter of minutes. The arm can be connected to a laptop via its USB port and imported directly into a compatible software application such as Rhinoceros. One advantage of this setup is that the digitising solution is also highly portable - the arm is relatively small in size and coupled with the laptop, easy to transport.

For example the arm could be used to digitally outline the surface of a mobile phone, then the digital model could be imported into Rhinoceros and variations made to its shape. Subsequently the remodelled shape can be sent to CNC for presentation to a prospective client.

5.9 Other Prototype Ideas

Our main target audience for the course is Product Design, Automotive Design and Architecture (images 1-5). However Prototyping is also used widely in other industrial areas, as shown below, such as sculpturing art, toys/ model submarines, confectionery, packaging design, cosmetics, jewellery, footwear, aviation and the Navy.

Images 1-4 copyright of David Copperwhite, 5-10 copyright of DeskProto, 11-12 copyright of Delcam.
5.10 3D Printing Resources on the Web

www.roundstonedigital.com a rapid prototyping service.

www.xpress3d.com a rapid prototyping service. It enables a purchaser to obtain multiple quotes for their design within a matter of seconds.

www.3dsystems.com manufactures solid imaging technology for concept models, master patterns for tooling and end-use production parts.

www.ZCorp.com Z Corporation develops, manufactures and markets 3D printers.

www.spinquad.com This online community has been set up for LightWave 3D professionals to gather and share their knowledge and experiences in CG and LightWave 3D.

www.licom.com produces the AlphaCAM software used by LinenHall.

www.deskproto.com CAM software used by the School of Architecture. With downloadable reference manuals and a free rhino plugin that enables you to print directly from Rhino. Contains many good Case-Studies and links to customer sites with examples of recent work using the package.

www.nist.gov/iges/igesTools.html information on the origin of the IGES file format used in many CADCAM machines today.

www.dit.ie/DIT/library/resources/subjects/engineering/index.html via the Bolton St. library you can check out the Rapid Prototyping Journal published by Emerald Group Publishing Limited. In volume 10, you can read about current advances such as prototyping using UV resin spray nozzles and also a comparative evaluation of current RP systems using a benchmark.

www.archimage3d.com provides 3D models, animations and renderings to architects and designers.
In this module we will use various elements in Photoshop such as Layers, filters and various tools from the Toolbox to blend the graphics into a professional looking cover design. We will also show how to create advertising T-Shirts using transfers, a functional prop in promoting your concept design during a presentation.

5.11 Taking a Screenshot and Cropping an Image

Take a screenshot of the model in the Rhino application window. Switch to Photoshop. Hit Ctrl + N for a new image and then Hit Ctrl + V to paste the screenshot image. We want to remove the outer edges of the image and just retain the model part. To do this we use the Crop tool. Select the Crop tool from the Toolbox, then click and drag a box around the area you want to retain. Hit return.
If you make a mistake use the History Palette to undo.
Select File | Save as
Save the file as rhino.jpg

5.12 Converting a Colour Image to Grayscale

From the menu select Image | Mode | Grayscale...
Hit Ok.
From the menu select Image | Adjust | Brightness/Contrast...
Brightness: +0; Contrast: +100 Hit Ok.

Now use the magic wand to select the white pixels.
1. Hit the delete key or
2. Go to the Toolbox and select the Foreground colour. The colour picker appears, select a light yellow colour. Hit Alt + delete to paint this colour onto the selection.

Select File | Save as
Save the file as BWrhino.jpg
5.13 Using a Filter to Create the Background

Use the File| New command to create a new file. You will be asked to select size of image etc. Set your canvas for an A5 size book i.e. when the book is folded out its dimensions are of an A4 sized page placed on its side. Allow a little extra for the book edge, say x cm. This will be found by trial and error. Input the following: Name: cover design, Image size: Height 21.0 Width 29.7 + x cm, (A4 size) Resolution: 300 pixels/inch, Mode: RGB Color, Contents: White. Hit Ok.

Resolution: The value you choose here should be determined by what you want to do with the image. On-screen viewing for web graphics looks fine at 72 pixels/inch. Most printers operate at 300 or 600 pixels/inch. Images such as book covers that you will print on top quality printers will require 1200 pixels/inch. Keep in mind that the greater the resolution, the greater will be the file size.

Go to the Toolbox and select the Foreground colour. The Colour picker window appears. Select a light blue colour. Change the Background colour to white.

Go to Filter| Render| Clouds... and a mixture of the blue and white Foreground and Background colours results.

5.14 Using Layers

Use File| open to open the Ansys.jpg, Juicer.jpg and deskproto.gif images. Make sure the Layers Palette is active - if not bring it up via the Windows menu. Now reselect the rhino file. Make its layer active, click on the layer and then drag and drop it into the cover design.psd image you created previously. A new layer should appear in the cover design.psd layer palette. Click & unclick the eye button to switch each layer on and off.

The layer containing the rhino image is too large and needs to be made smaller. Make it the active layer, then select Edit| Transform| Scale... from the menu. Hold down the SHIFT key while re-sizing to keep the aspect ratio constant while dragging the handles from any corner and shrink the Layer. Hit return to accept the resizing.

Use the select button from the Toolbox together with your arrow keys to nudge the Layer to its desired location.

If you make a mistake use the History Palette to undo.

Repeat the process for the other images.

Select the DIT layer and reduce its opacity to 25%. This makes it fade into the background.

Right-click on the Layer name in the Layers Palette, select Layer Properties. Give the layers names like Rhino, ANSYS, Deskproto, DIT, Juicer, Clouds. If you do this it will be easier to select the relevant layer when applying changes, aligning etc.
5.15 Adding Text

Select the Text tool from the Toolbox. From the Options bar, make the following adjustments:

Font: Tahoma; Size: 30pt; Anti-Aliasing Method: Crisp; Text color: Blue 1A7ED5

Click and drag a box in the canvas area. Try typing the sample text:

**Juice Expresser ProtoType**

A text layer will appear in the Layers Palette.

Repeat by creating another text Layer for the authors’ names.

Try typing the sample text:

**Jerome Casey Barry Duignan David Copperwhite**

This time use 24pt and a red font colour.

Select File| Save as
Save the file as *cover clouds.jpg*

5.16 Variations: Using the Gradient Tool/ Other Designs

Switch off the Clouds layer by ticking its visibility button. Create a new blank layer by choosing New Layer from the Flyout Layers menu of the Layers Palette.

Use the colour picker to set

- Foreground colour = blue
- Background colour = white.

Rename the Layer as Gradient.

Now select the Gradient Tool from the Toolbox and draw a line horizontally across the canvas, about 18cm down the page (Hit Ctrl +R to show rulers). If the tool is not immediately obvious, it could be hidden underneath the Paint Bucket Tool, located to the right of the Eraser tool.

Drag this Layer to the bottom of the stack to see the overall cover.

Select File| Save as
Save the file as *cover gradient.jpg*

A gradient is a smooth wash of colour moving from one colour to another so smoothly that the eye cannot detect where one colour stops and the other begins. Natural examples of colour gradients include rainbows and sunsets.

Alternatively...

Switch off the Gradient layer by ticking its visibility button. Open the *ipod.jpg* file. This has a nice colour scheme on the right hand side. Use the crop tool to single out this area. Hit return to confirm. Now select its Layer and drop it into the *cover design.psd* image.

- Rename the Layer as scheme.
- Resize the image to fill the entire canvas.
- Drag this Layer to the bottom of the stack to see the overall cover.

Select File| Save as
Save the file as *cover scheme.jpg*

Select File| Save as
Save the entire *photoshop* file now as *cover design.psd*
By keeping a copy in .psd format with all the Layers intact you have the option of changing the design at a later date, if so desired.

5.17 Printing the Book Cover

Repeat the process for the back cover. Insert your paper in the printer. I use HP, grade 170, semi-glossy. You also need to use a printer that can print to the edge. You should have a paper size greater than A4 to account for the book edge. You can then print the full cover and do a wrap-around. If however you have just A4-size paper you can crop the front and back covers independently to A5-size and print the sides separately. Then use a guillotine to trim the edges. Select File | Print Options. Click on Page Setup and select A5 paper (width 21cm, height 14.8cm). Make sure the Scale To Fit Media box is checked. You will see a preview of how the cover will look. Check the Show Bounding Box if desired.

Select File | Print. In the Print Space section ensure the Profile is Same As Source.
5.18 Creating Advertising T-Shirts

We can use the image created and make up advertising T-Shirts using transfers. Use the same image or by a similar process make up another in Photoshop. When you are finished select Edit| Transform| Flip... from the menu. This will ensure your image will come out the right way around. Alternatively, your printer might have the option to flip the image in its Properties dialog window. Place your transfer paper in the printer and select File| Print from the menu. I used Avery T-Shirt transfers. It is recommended to use a 100% cotton fabric and to wash the material, then dry before applying the transfer. This ensures that the material will not shrink during use. Pre-iron the material for 10-15 seconds. Position the transfer on the T-Shirt with the printed side down, iron, allow to cool and then peel off.

5.19 Working with Color Modes

Recall that when creating a new image in Photoshop, you were asked to select an image mode. The default is RGB mode. Photoshop allows you to work in a variety of Color Modes, though, and there are specific reasons for choosing each one.

- RGB: The standard display mode for monitors, which create colour by mixing red, green, and blue phosphors. These three colours, when mixed together form white, an additive colour. It can contain many colours that are impossible to print. Most scanners (especially desktop models) scan images into RGB space. All Photoshop operations are allowed in RGB mode, so you’ll probably work in this mode most of the time.
• **CMYK**: Works with conventional colour printing, which uses four inks - cyan, magenta, yellow, and black - to reproduce all colours, and it allows you to produce colour separations. It is a *subtractive* colour mode, since it is necessary to remove all colour to get white. It has a much more limited colour gamut than RGB. A CMYK image contains four colour channels, making it automatically about 25% larger than the same image in RGB mode. It can be layered and rotated at any angle, and can use most but not all Photoshop filters.

Colour mode can be changed at any time when working with an image by going to the **Image** menu and choosing the appropriate option from the **Mode** sub-menu. Be aware that as you go down the list, the file sizes become larger. For most purposes, you will only use grayscale, RGB, CMYK, and Indexed Colour colour-modes.

**Bit Depth**: Beneath the list of colour modes, you will notice a bit depth for your image of either **8 Bits/Channel** or **16 Bits/Channel**. Bit depth indicates the level of colour information saved with a pixel; a pixel with a bit depth of 1, for example, has only two possible values: either black or white. Higher bit depth makes for better colour matching between the image you see on your screen and the image you output. Occasionally, you may notice that some of Photoshop’s features (such as filters) may not work in 16-bit depth; to turn “greyed-out” options back on, you can change the bit depth to 8. All of Photoshop’s features are available at this bit depth.

**Note**: when you decrease the resolution (lowering the image quality), the print size becomes bigger. That’s because resolution (usually in pixels per inch) and print size (in inches or cm) are both linked to pixels. Think about resolution like population density: if you originally had 300 people per inch in a one-inch-square, then dispersed them to only 72 people per inch, they’d spread out—making the area bigger (4.17 inches square, to be exact). You didn’t get rid of any people, so you had to put them all somewhere, causing your area to get bigger. The same concept holds true for pixels in your image in relation to the print size. This principle also means that when you decrease the print size, the image’s resolution will increase to maintain the same number of pixels spread across a smaller area.
PowerPoint is an application designed to help you translate your ideas and thoughts into powerful presentations. PowerPoint is equipped with many utilities such as professional-looking templates that serve to add impact to your presentations while making the process of creating your slides extremely easy. In addition, PowerPoint can translate your data into charts which can facilitate your audience’s understanding. Furthermore, you can turn your presentation dynamic by combining your work with sounds, pictures, or even movies. You can even build in your own animations in your presentation.

At this stage the aim is to collate all available data into a digital presentation or printed report. For the purpose of demonstrating the digital presentation side we will recreate the presentation given on day 1 outlining the course. When you are finished the slides will look like this:
5.20 Getting Started in PowerPoint

The Five Views of PowerPoint

There are five different ways that you can view and work on the slides in your presentation. The following icons can be found in the bottom left corner of the PowerPoint screen.

- **The Slide view** is used for editing the text and formatting the layout of the slide, one slide at a time.
- **Outline view** is used for organising and entering the information of your presentation.
- **Slide Sorter view** is used to arrange slide order and transition effects.
- **The Notes Page view** is helpful when you want to add notes for the presenter. It displays a smaller image of the slide and a box you can use to add notes on your slides. You can use these notes as a memory aid during your presentation to remember what to say.
- **In Slide Show view** you can see what your presentation will look like, as well as what individual slides look like.

When PowerPoint opens you will be looking at a window labelled "Create a new presentation using". In this window choose **Blank Presentation** and left-click on the OK button.

The "AutoLayout" window will appear. For your first slide select the **Title layout option** in the top left corner and click on the OK button.

Add the Title as shown by copying and pasting from the powerpoint.txt handout file.
5.21 Changing the Background Design

1. Click on the Slide View icon in the bottom left corner of your screen.
2. To change the background design of all of the slides choose Format| Apply Design Template. This brings up a window with a wide variety of different designs. You can preview a particular design from the list by clicking on the name of that design with the left mouse button. You can also use the up and down arrows on the keyboard to preview designs.
3. Choose a template (Factory) and exit the window by clicking on the Apply button. If you’ve done everything correctly your background will have changed.

5.22 Adding a Picture or an Animation to a Slide

1. From the menu bar, select Insert| Picture| From File... to choose a picture saved on a disk or in another location (Note: To use a clip art image select Clip Art...).
2. Click on the down arrow next to "Look In:" and select the folder where the picture is stored on the network.
3. Double-click on the image called DIT Logo to select that image.
4. To change the size of the image, click on the image's handles and drag in or out while holding the mouse button down.
5. To move the image to the position you want it on the slide, click on it and while holding the mouse button down move it where you want it (Note: The picture is selected for moving when the mouse pointer turns into a four headed arrow).

Animated gifs are inserted as above and don’t animate until you are in Slide Show view.

To insert a movie file select Insert| Movies and Sounds| Movie From File... We will use this in the slide on milling. Choose the file from the folder as above.
5.23 Adding a Watermark and Action Buttons to the Slide Master

When you work with PowerPoint's "Slide Master" slide, you can make changes or add elements that affect every slide in the presentation except the Title Slide. This is an efficient way to quickly edit every slide in a presentation. In this assignment we'll add two elements to the Slide Master slide: A "watermark" and action buttons.

To open the Slide Master slide for editing, choose View|Master|Slide Master. PowerPoint shows you an edit environment that looks very similar to "Normal View". However, in the Slide Master View your focus is only on slide layout. In addition some extra slide layout areas (such as the footers) are visible.

Find a graphic that you think would be appropriate as a "watermark", to appear on every slide. A watermark appears as a sort of background image, in semitransparent form. You could select an image from the Clip Art Gallery (Insert|Picture|Clip Art) or from a file, which is what I did. Insert the DIT icon.

Position the graphic in the upper right-hand corner of the slide. Adjust the size, as necessary, to suit yourself.

The "Picture" toolbar normally displays in the workspace automatically when a graphic is selected. If not, turn it on by choosing View|Toolbars|Picture from the menus.

Find the "Set Transparent" button, the button second from right on the "Picture" toolbar.

Click this button and the cursor changes, select a white area on the DIT icon to get a watermark effect.

This graphic will now appear with this aspect and in this position on every slide but the title slide.
Before leaving the Slide Master environment, add one more element - “Action buttons”. Action buttons are ready-made buttons that appear pressed in when you click them during a slide show and are associated with actions such as moving forward or backward through the slide show. A “Home” action button is also useful to add.

To insert an action button, choose Slide Show| Action Buttons and then click the button you want from the button palette that displays.

Then click in the Slide Master to insert the button. An “Action Settings” dialog immediately displays to allow you to assign an action to the button.

Insert the Forward Button and the Back Button from the button palette. For action settings, take the PowerPoint defaults (e.g., “Next Slide” and “Previous Slide”). Locate the buttons at the lower edge and in the centre of your Slide Master slide. You may want to size the buttons to a smaller size than their defaults. If you double-click each button its formatting window will open. Click on the Size tab and resize the button to 1cm by 1cm.

My positioned and sized “Back” and “Forward” buttons look like this in the Slide Master slide:

Exit Slide Master mode by clicking the Close button on the “Master” toolbar. Or, if you don’t have the “Master” toolbar displayed, choose View| Normal from PowerPoint’s menus.
Click through your slides in Normal mode to see that your watermark and navigation buttons appear on all but the first (title) slide. Put your presentation in Screen Show mode and check to see that your buttons work. Both buttons will appear on your last slide but only the “Back” button will work on that slide.

5.24 Inserting a Bulleted List Slide
1. From the menu bar, select Insert| New Slide.
2. From the "New Slide" window that opens select the option for a Bulleted List. This is the second option from the left in the top row. Click Ok.
3. In the title box type: Introduction
4. Copy and paste the relevant text from the powerpoint.txt file.

If necessary, alter the text font size and the size and placement of the text boxes.

5.25 Inserting a Table Slide
The third slide in your presentation is a table slide. In this slide I’d like you to include a table with two columns and two rows. From the menu bar, select Insert| New Slide. From the "New Slide" window that opens select the option for a Table. This is the fourth option from the left in the top row. Click Ok.

Alternatively you could select the “Title Only” layout and copy and paste a table you’ve generated in Word. Fonts are 18 point Arial. Use the Tables and Borders Toolbar to help you add orange shading to the first header row. Add some bullets.

5.26 Using Microsoft Draw in Slides
Microsoft Draw is a useful add-in for drawing attention to important points on your slides. Select the Oval shape and draw. Select the Curved arrow connector (or an arrow) from the Autoshapes menu of the Drawing Toolbar and draw. Select the Line Color and change it to red. Select Line Style and increase it to 3pt.
Use the select button to pick a selection around the Juice Expresser, including the oval and arrow, then select Draw Group. Use the SHIFT key to select all the individual elements. Later when you come to run the slide show this group ‘enters’ as one block. This looks more professional.

You should also experiment with the various Autoshapes. In slide 8 I used a Horizontal Scroll, located in the Stars and Banners submenu. To insert text inside the shape, click on the Text box icon and drag out an area large enough to fit-in the amount of text you want.

### 5.27 Adding Transition and Build Effects to Slides

Another method for improving the impact of your presentation is to use transition and build effects. Transition effects are used during the transition from one slide to the next. Build effects are used in building within a single slide. The transition effects add sparkle to your presentation. Build effects are useful for hiding and revealing only parts of the slide during the presentation to give the “peep show” effect. Some examples of transition and build effects include dissolve, wipe down, wipe up, and fly from right/left.

To apply transition or build effects to your slide, go to the Slide Sorter view.

Once you are in the slide sorter screen look for the toolbar that is used for the transition and build effects. The toolbar looks like this:

![Slide Sorter Toolbar](image)

To apply a transition effect, first select the slide that you want to apply the effect to by clicking once on the slide. The selected slide should have a highlighted border around it. Next, press the drop down arrow on the transition section of the slide sorter toolbar to produce the above list of transition effects.
To select a transition effect, simply choose one of the options from the list provided. Note that you are choosing how the selected slide will initially be drawn. To check out the transition, click on the Preview button at the bottom right of the screen and move through the slides.

Applying build effects allow you to hide bulleted text and "build" the slide slowly, revealing one point at a time or one picture object at a time. Applying build effects is very similar to the process of applying transition effects. You first must be in the slide sorter view. You then select the slide you want to apply the build effect in and press the drop down box to view the list of build effects. This is shown across:

For even more control over the way a slide builds go to Slide view. For example, select slide 4 and add animation to the bullet points or slide objects by right-clicking the text area of the slide and choose Custom Animation from the pop-up menu that displays. Choose animation effects by completing the "Custom Animation" dialog that appears.

Select the Order and Timing tab to set it so that a picture appears before a certain group of text. Use the up and down arrows to do this. You can also control whether text appears automatically after a number of seconds or on the mouse-click. Select the Effects tab to set sound effects as the object enters or to set the after animation appearance e.g. if you want text to appear dimmed after animation.

Have a look at slide 6

Order & Timing Tab
1. Set the Title textbox to be shown automatically when the slide is introduced.
2. Set the following textbox to be shown On mouse Click.
3. Note up and down arrows to change animation order of what is revealed next. Notice when you add another text box field you can order it to appear after the Picture.
Effects Tab
1. Select the second Text object. **Entry animation:** Fly from left all at once and **After animation:** coloured light blue.
2. Select the picture and Apply a Dissolve transition effect.

View the animation effects by clicking the **Preview** button from this dialog. Or, move to Slide Show mode and run.

**Slide Sorter View** however, is probably the easiest view to animate a show. By selecting each slide individually or groups of slides you can control not only the way a slide appears as you move from slide to slide (transition), but also the way each item builds within a slide.

### 5.28 Creating an Agenda Slide

You can direct *PowerPoint* to generate an agenda slide that lists the main segments of your presentation. In this assignment, you’ll create an agenda slide that lists all the slides (bulleted, table etc. but not including the title slide) in your presentation.

To create an agenda slide, switch to Slide Sorter View and select the slides whose titles you want to use. Hold down the **Shift** key and click each slide you want to select.

In Slide Sorter View, the Slide Sorter toolbar is visible. On that toolbar, locate the “Summary Slide” button and click it.

*PowerPoint* generates a new summary or agenda slide from the titles of all your selected slides. It locates the new agenda slide in front of the first selected slide. In this case, your agenda slide should appear right after the presentation title slide. I later moved it to become the second last slide while in Slide Sorter View.

*PowerPoint* gives the agenda slide the title “Summary Slide”. The titles of all of your main slides should appear as bullet point items on this slide.
5.29 Creating Hyperlinks from the Agenda Slide

The last task in this assignment is to create hyperlinks from each bullet point item in the agenda slide to the corresponding slide in the presentation. We’ll add web-style hyperlinks.

Return to Normal View and make your agenda slide current.

1. Highlight a bullet-point item and right click to open the context menu. From the context menu select Hyperlink. The “Insert Hyperlink” dialog opens.
2. Click on Bookmark. The “Select Place in Document” dialog opens.
3. Choose the appropriate slide in the dialog and click Ok. Click Ok again to close the “Insert Hyperlink” dialog.

PowerPoint establishes the hyperlink and indicates that it’s “hot” by underlining the bullet point entry in the slide. Now in Slide Show mode, the underlined entry works like a web hyperlink.

Complete the links for all the other bullet-point items. Then put your presentation in Slide Show mode and test the links.

You might find it useful to add a hyperlink for each of the slides back to the agenda slide. You can add a hyperlink to text (as we did with the bullet-point agenda items), or to a graphic (as we did with the navigation buttons). To do this open the Slide Master slide again as before by choosing View|Master|Slide Master. Insert the Home action button beside the two existing buttons. When prompted hyperlink to Slide and choose the Summary Slide. Once again put your presentation in Slide Show mode and test that the Home action button brings you back to the Summary Slide.
At the end of a presentation, after the last slide has been shown, the display will go to a blank black slide and then back to the PowerPoint slide view. This can be distracting during a presentation, so here's a suggestion. Go to Slide Sorter view, select the Title Slide and Copy it. Place the cursor directly to the right of the last slide and Paste. This means that the presentation ends where it started - on the Title Slide. As well as looking better it reminds the audience once again of the presentation title and your name!

5.30 Viewing Your Presentation

When you are satisfied that your presentation is the way you want it you can view it by clicking on the Slide Show View button in the lower right corner of the screen. If you have preset times for slide transitions and animation effects you can sit back and enjoy the show. If not, you can move from slide to slide by clicking with the mouse button, pressing the space bar or using the action buttons you created. To end the presentation at any time, press the Escape key.

5.31 Printing Your Presentation

PowerPoint has a number of convenient print options available. Explore the "Print what" option in the File | Print from the menu. It is always a good idea to provide Handouts for your audience so they can follow along with the presentation. Two slides per page is a good rule of thumb, I used four here though. You can also choose to print in Pure Black and White if you want to save the colour ink in your printer. The Notes pages are useful for the speaker to add additional notes and reminders. Speaker's notes are not visible to the audience during the presentation but can be printed for use by the speaker as a reminder during the show.
Presentation Checklist

The PowerPoint presentation should have 16 slides constituted as follows:

<table>
<thead>
<tr>
<th>Slide No.</th>
<th>Slide Layout</th>
<th>Slide Transition</th>
<th>Build Effects</th>
</tr>
</thead>
<tbody>
<tr>
<td>Slide 1:</td>
<td>Title slide with icon.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Slide 2:</td>
<td>A bulleted-list slide with at least two bullet points</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Slide 3:</td>
<td>A table slide with two columns.</td>
<td></td>
<td>Peek from bottom</td>
</tr>
<tr>
<td>Slides 4-14:</td>
<td>Bulleted-list slides with pictures,</td>
<td>Slide Transition</td>
<td>Build Effects</td>
</tr>
<tr>
<td></td>
<td>Microsoft Draw and embedded avi or gif.</td>
<td>4 -</td>
<td>Fly from top</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5</td>
<td>Fly from left</td>
</tr>
<tr>
<td></td>
<td></td>
<td>6</td>
<td>Fly from left, picture Dissolve, text dims after animation,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>7</td>
<td>Fly from left, picture Dissolve</td>
</tr>
<tr>
<td></td>
<td></td>
<td>8 Dissolve</td>
<td>Text Wipe Down, Pictures Fly from left</td>
</tr>
<tr>
<td></td>
<td></td>
<td>9</td>
<td>Dissolve</td>
</tr>
<tr>
<td></td>
<td></td>
<td>11</td>
<td>Fly from left</td>
</tr>
<tr>
<td>Slide 15:</td>
<td>A final slide, The Title slide.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Slide 16:</td>
<td>An agenda slide that lists the titles of slides 1 through 15 with a hyperlink from each bullet - point item to its corresponding slide.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

1. Navigation buttons on each slide (other than the title slide) that permit the user to move forward and back through the presentation and ‘home’ to the agenda slide.
2. A graphic as a watermark, appearing at the top right of each slide other than the title slide.
In presenting a professional report some important elements to include are a Table Of Contents, distinctive chapter headings, page numbering and an Index. Also the document will look better if headings and sub-headings throughout the report have distinctive formatting, font type, size etc. One way to accomplish this is through the use of styles. A style is a tool for recording paragraph or character format settings that can be inserted anywhere in the document by just referring to the style name in the style box in the top left hand corner of the formatting toolbar. Word provides a number of built-in heading styles that we can use to create a Table Of Contents. We’ll then repeat the exercise by making up our own styles and directing Word to build a new Table Of Contents from these styles.

At this stage the aim is to collate all available data into a digital presentation or printed report. For the purpose of demonstrating the printed report side we will recreate the layout of part of this course book creating a Table Of Contents, distinctive chapter headings, page numbering and an Index. A starter file is provided.

5.32 Applying the Built-in Heading Styles

We are going to make use of Word’s built-in heading styles throughout our document. As well as avoiding stylistic inconsistencies, styles are also used to construct the Table Of Contents.

Apply the required style, whether Heading 1, 2, or 3 by observing the indentations in the screenshot below from the Handout Exercise. Add the appropriate styles to each of the headings, Heading 1 for the chapter heading, Heading 2 for the next lower level etc.

5.33 Inserting the Table of Contents

5.34 Creating a Style by Example

5.35 Adding Section Breaks

5.36 Inserting Headings

5.37 Inserting the Page Numbers

5.38 Inserting the Index
5.33 Inserting the Table of Contents

Go to the first page of the document and position the cursor where you want the table of contents to appear. If you have applied built-in heading styles to headings, Word can use the heading styles to create a table of contents.

Select Insert | Index and Tables... menu, a window appears like below. Select the Table Of Contents tab. In the Formats drop-down box, select the Formal format to create a table like that shown in the Preview. You can also choose to show the page numbers and also the type of leader to be used. Click Ok.

5.34 Creating a Style by Example

You can create a new style using Format | Style... then click on the New button. Another way to create a new style is by example. Create a paragraph containing all the settings you want in the style: character type and style, paragraph indentations, tab settings, etc. Then position the cursor in the Style box, type a new name for the style, such as myH1, myH2 or myH3 and press Enter to accept.

Apply the styles like before to the various subheadings. Return to where you want to insert the Table. As before select Insert | Index and Tables.... Click Options. Under Available Styles, find the style that you have applied. Under TOC level, to the right of style name, enter a number from 1 to 9 to indicate the level you want that style heading to represent. Click Ok.

Note: You could use this method to create a Table of Figures or a Table of Tables.

Delete the other numbers. This means that in building the new table of contents Word will only look for these new styles and not Heading 1, 2 or 3. Click both Ok buttons. Click Yes in the window that appears “Do you want to replace the selected table of contents”.

Jerome Casey

Report Writing Using Word
5.35 Adding Section Breaks

When you create a header or footer, *Word* automatically uses the same header or footer throughout the entire document. To create a different header or footer for part of a document, divide the document into sections, and then break the connection between the header or footer in the current section and the previous one.

Divide each chapter up into separate sections using **Insert | Break...** In the Section breaks part toggle **Next Page**. Select **View | Header and Footer...** A toolbar appears like below:

5.36 Inserting Headings

Use the **Show Previous** and **Show Next** icons to flick between the various sections. Go to the first page of chapter 1. Click on the **Page Setup** icon, click the **Layout** tab (if it isn’t the one showing) and select the **Different First Page** check box option. This has the effect of ensuring that the heading you type doesn’t appear on the page a chapter starts on (the first page), only the following pages. Click the **Show Next** icon to go to the second page of chapter 1, where you want to insert the heading.

Insert the header using **Insert | Cross-reference...** In the **Reference type** box, click **Heading**. Untick the **Insert as hyperlink** tick-box. In the **For which heading** box, click the heading that contains the chapter number and title (in this case *Using Photoshop To Create Texture Maps*). Click **Insert**. Now if you change this heading in the body of the document, the header will automatically update these changes because you have added it as a Cross-reference. Repeat for the other headings, but beware. *Word* will automatically adopt the heading from the previous section, so you have to break this connection by making sure the **Same as Previous** icon is ‘off’.
5.37 Inserting the Page Numbers

Usually the first pages of a book are formatted as roman style numerals, and the more familiar 1, 2, 3 format only starts on the first page of chapter 1. To achieve this go to the document’s first page, on which you have the table of contents, switch to the footer view and Insert Page Number. Right align the number, use the tab button if you need to. If the correct type doesn’t appear, select the number, then click on the Format Page Number icon. A window appears. Select the roman numeral style, Start at should be 1 for roman numerals. Now click the Show Next icon to go to the first page of chapter 1. As with the heading you have to break the connection between sections for the footer by making sure that the Same as Previous icon is ‘off’, otherwise Word will keep incrementing the page number using 'roman numerals'. So while still in Footer view, break the connection and Format Page Number as normal 1, 2, 3 style, Start at should be 1. Now go to the next section (chapter 2) using the Show Next icon, and ensure that the numbering is going ok. If not, select the number, click the Format Page Number icon and make sure that Continue from previous section is on and leave Start at blank. Word will figure out what page to start counting chapter 2 from, as this depends on the amount of pages in chapter 1.

5.38 Inserting the Index

To create an index, you must first mark the index entries - such as words, phrases, or symbols - in your document. Once you’ve marked all the index entries, you choose an index design and build the finished index. Word then collects the index entries, sorts them alphabetically, references their page numbers, finds and removes duplicate entries from the same page, and displays the index in the document.

a) Mark the index entries in your document. Select the text you want to use as an index entry, e.g. select the word 'Rhino'.

b) To mark the index entry, on the Insert menu, click Index and Tables, and then click the Index tab. Click Mark All, to mark all occurrences of the word in the document.

c) Word inserts each marked index entry as an XE (Index Entry) field in hidden text format. If you don’t see the XE field, click the Show/Hide button. Now repeat for all the other words you want indexed.

d) Click where you want to insert the finished index (usually the last page).

e) On the Insert menu, click Index and Tables, and then click the Index tab.

f) To use one of the available designs, click a design under Formats (fancy) and right align the page numbers.

g) You can also design a custom index layout.

Tip: If you want to avoid words or phrases from the initial pages of a document being indexed - say for example the words from the Table of Contents being indexed - you can achieve this by simply deleting the index fields using the delete or backspace key. If you can’t see the XE field, click the Show/Hide button. Don’t forget to then update the Index.

To update an existing index, position the insertion point anywhere in the index and press F9. More simply you could create the Table of Contents last to avoid this happening.
The End
Contact Information:

School of Civil & Building Services Engineering,
D.I.T., Bolton St., Dublin 1.

David Copperwhite Tel:+402 3769  E-mail: david.copperwhite@dit.ie
Jerome Casey       Tel:+402 3769  E-mail: jerome.casey@dit.ie
Barry Duignan      Tel:+402 3881  E-mail: barry.duignan@dit.ie

In conjunction with Staff Training and Development

CD - ROM Included